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Figure 1. NPM3100

The Quaesta Instruments NPM3100 Series of Neutron Pulse Monitors (NPMs) is
intended for use with proportional neutron detectors, including Helium-3 (He3), Boron
Trifluoride (BF3), Boron-lined types and others. The NPM3100 is a low power
consumption, digital device with integrated high voltage, digital counter, multichannel
analyzer (MCA), and data logger. It is capable of autonomously counting and analyzing
proportional detector signals, producing neutron pulse height spectra, and generating
list mode data.
The NPM3100U, USB version, communicates via a USB interface for device
configuration and data transmission. A TTL output is used to signal neutron
counts. Additionally, a TTL input can be configured to log external TTL pulses
and/or transmit then through the TTL output along with internal neutron counts.
This daisy chain operation is useful in detector arrays.
The NPM3100E, Power over Ethernet version, communicates via an Ethernet interface.
This device can operate in conjuction with an external clock that allows timing
synchronization among an array of NPMs.
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3 Overview and Hardware
3.1 Customer Support
PHONE:

(520) 882-3706

INTERNET:
www.quaestainstruments.com
support@quaestainstruments.com
WRITE:
Attn: Customer Support
Quaesta Instruments, LLC
1665 E. 18th St, Ste 207
Tucson, AZ 85719 USA

MANUAL REVISION INFORMATION:
Version 1: Feb 16 2015
Version 2: Sept 10 2015
-

Added and cleaned up Tables for Command Description and Quick
Reference
Cleaned up Appendices related to NPM3100U interfacing. Added description
of Teraterm Pro setup and connection.
Numerous other additions

Version 3: May 12, 2016
Version 4: Jun 10, 2016
-

Revised ListMode Data description

Version 5: Oct 6, 2017
Version 6: Oct 12, 2018
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3.2 General Safety Information

Do not operate the hardware in a manner not specified in this document and in the user
documentation. Misuse can be hazardous. If the hardware is damaged, the safety of
the device may be compromised. If you suspect damage, return the device to Quaesta
Instruments for repair or replacement.
Clean the hardware with a soft, nonmetallic brush or cloth. Make sure that the
hardware is completely dry and free from contamination before returning it to service.

3.3 High Voltage Warnings
The hardware has a high voltage output (HN connector) that operates up to 2500VDC
(depending on the HV option selected at time of purchase). Never touch the HN
Connector’s center pin with your hand or other probing device. Never operate the
hardware with the high voltage (HV) connector exposed. HV levels of 70V DC and
higher can pose a shock hazard.
Use an approved connector plug or cap or attach to an approved high voltage
proportional tube before turning on or applying power to the device.
Care should be taken to not short the HN connector center pin (HV) to the HN
connector metal housing (GND). This may damage the device electronics.
The HV level cannot be measured with a standard voltmeter. Attempting this is
hazardous. Contact Quaesta Instruments if you need to make direct measurements of
the high voltage. The high voltage level is measured internally by the device and this
information can be obtained through communication with the device.

3.4 Electromagnetic Compatibility Guidelines
This product was tested and complies with the regulatory requirements and limits for
electromagnetic compatibility (EMC) as stated in the product specifications. These
requirements and limits are designed to provide reasonable protection against harmful
interference when the product is operated in its intended operational electromagnetic
environment. This product is intended for use in commercial and industrial locations.
There is no guarantee that harmful interference will not occur in a particular installation
or when the product is connected to a test object. To minimize the potential for the
product to cause interference to radio and television reception or to experience
unacceptable performance degradation, install and use this product in strict accordance
with the instructions in the product documentation
9
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4 Section 1: NPM3100 Device Overview
4.1 Device Architecture
The NPM3100 series neutron pulse monitors are digital, microcontroller based devices.
They include two primary sections: a high voltage and analog amplifier section, and a
digital waveform capture and analysis, and communications section. Firmware in the
microcontroller is used to produce a variety of outputs and functions. Therefore, this
NPM3100 series is able to offer many features, and they are a flexible platform for rapid
development of new ones. A Command Set controls all device operation from
configuration of operational parameters to transmission of data from the NPM. A
terminal window program (such as Tera Term Pro) can be used to communicate with
and control the device from a command line using the device’s Command Set.
Additionally, some devices have a GUI software interface to control the device. At a
device interface level, this GUI software utilizes the same Command Set which a user
can enter from a terminal window. Throughout this user manual, examples of
commands from the device Command Set and how they would appear in a terminal
interface window (program) are shown as examples.

4.2 Analog section
The high voltage supply is actively controlled, stable and has low noise. The analog
section (Figure 2) includes a low-noise charge sensitive amplifier, pulse shaper, fixed
gain amplifier, and a variable gain amplifier. The incoming charge pulse from the
neutron detector is shaped, amplified and buffered. The signal pulses from some
neutron detectors are quite small, containing on the order of a few femtoCoulombs of
charge; therefore, low noise amplification of these signal pulses is critical.

4.3 Digital section
The digital section (Figure 3) includes a microcontroller, analog-to-digital converter
(ADC), communications chip, real-time clock and SD card(s). The analog shaped pulse
is digitized in the ADC. The microcontroller applies various firmware algorithms to the
digitized pulse for analysis. For example, the detector signal pulse height is measured
and compared to the digital discriminator levels to determine if a signal pulse is valid.
Other functions such as a digital counter, multichannel analyzer (MCA), data logger and
device communications are managed by the microcontroller.

10
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Figure 2. Analog Section.
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Figure 3. Digital Section.
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4.4 Outputs and Functions (Overview)
A range of outputs and functions (Figure 4) are available for the NPM3100 series.
Generally, these are controlled by the device Command Set. Outputs and Functions
include:
4.4.1 Digital Pulse Waveform:
The shaped signal waveform is digitized by an ADC. This digitized waveform (256
points with 125nsec timing resolution) may be accessed by the Pulsewave command
which causes the NPM to print the next retrieved waveform to the output of its
communications line. Pulse Waveform does not operate asynchronously, but is
prompted only by a command. A GUI application may be used to display the digital
shaped waveform.

Figure 4. Outputs and Functions.
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4.4.2 Digital Discriminator:
A digital upper and lower discriminator may be specified by the user. When a pulse
height is measured, it is compared to these two discriminator levels and is considered a
valid neutron count if it falls between them.
4.4.3 Digital Counter:
When a valid neutron count is measured, an internal digital counter is incremented (> 4
billion counts). A query command allows the user to download digital counts and an
elapsed time indicating the length of time in which the counts have accumulated. The
time returned here has a resolution of only 1 second. Higher timing resolution can be
achieved by using the Datalogging feature of the device (to precisely and periodically
sample the counts). The user may also control the interval of sampling precisely by
utilizing an external timer to control the query of counts information.
Set the TTLCounter parameter to a value of 1 to activate the counting of TTL Input
pulses.
Note: List Mode data allows the user to timestamp individual pulses to 500 nanosecond
resolution
4.4.4 Pulse Output:
The NPM3100U model has a standard TTL Output line (SMA connector) that may be
configured to emit a TTL pulse under two conditions:
a. TTL output pulse emitted with each neutron count.
b. TTL output pulse emitted with each input TTL pulse (pulse forwarding).
c. TTL output pulse with each neutron count and with each input TTL pulse
(pulse forwarding)
See the TTLOutWidth and TTLMode parameters to configure the Digital Pulse Output
behavior.
4.4.5 Pulse Input:
The NPM3100U has a standard TTL Input line (SMA connector) that may be configured
to count and log external input pulses with frequencies as high as 40MHz. As
mentioned above in section 4.4.4, an external TTL pulse can cause the TTL Output to
emit a TTL pulse, effectively transmitting the external TTL pulse through the NPM. This
capability is useful in array applications in which multiple NPMs are connected in series,
in a ‘daisy-chain’ fashion.
See the TTLOutWidth and TTLMode parameters to configure the Digital Pulse Output
behavior.
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4.4.6 Temperature & Humidity Sensor:
An optional temperature and humidity sensor may be installed in all NPM models as a
diagnostic tool for monitoring the device environment.
4.4.7 MCA: Pulse Height Spectrum:
The NPM has a multichannel analyzer function that measures the signal strength or
‘height’ of each neutron signal pulse and is able to store the number of counts for each
pulse height in a histogram. The user may specify the number of bins in this pulse
height spectrum, or histogram. The number of bins must be one of the following: 64,
128, 256, 512, or 1024. Each bin can record over 4 billion counts. The user may use
the Command Set to specify the number of bins in the histogram. Additionally the user
may query the current accumulated histogram or zero the histogram at any time . If the
Datalogging option is selected, the user may configure the time period at which the
histogram is periodically recorded. For further details, see Section 6.6.7 .
4.4.8 Differential Arrival Time Spectrum:
The NPM can measure the time between successive neutron counts and record these
times in a Differential Arrival Time spectrum, or DT Histogram. The Delta T time per
DT histogram bin size is user selectable in 1 usec levels. This function is useful in
neutron coincidence counting. For further details, see Section 6.6.8 .
4.4.9 Data Logging:
The NPM has a real-time clock and can record device data, repeatedly, for a user
specified period of time. The user also selects what type of data is recorded. Logged
data is recorded to an internal SD card in FAT32 file format. Data which can be
logged include: the number of neutron counts, temperature, humidity, external TTL
input pulse counts. The Pulse Height Spectrum histogram may also be logged.
4.4.10 List Mode Data Logging:
NPM3100 series devices can sample and record the pulse height and arrival time of
each individual neutron count with 500nsec resolution. This function has value in
applications involving both individual NPMs and arrays of NPMs such as often used in
Nuclear Non-Destructive Assay (NDA) tools.
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5 NPM3100 Technical Specifications
5.1 Mechanical Specifications NPM3100U & NPM3100E
Physical Components

NPM3100U Device

Dimensions

1in OD x 4.4in length (2.54cm OD x 11.2cm). Cylindrical
profile.

Enclosure Finish

Anodized aluminum (blue).

Options:
-HN Male with Swivel Nut or HN Female.
-SHV Male or Female.
High Voltage Connector
-MHV Male or Female.
-Pigtails with HV cabling and HN, SHV, or MHV
terminations may also be provided.
Communication Connector Micro USB.
LED

Indicator LED (red) on rear panel.

TTL Input

SMA Connector, Female, threaded.

TTL Output

SMA Connector, Female, threaded.

Table 1: NPM3100U Mechanical Specifications
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Figure 5. NPM3100U Device Dimensions

Figure 6. NPM3100U Rear Panel
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NPM3100E Device

Dimensions

1in OD x 5.2in length (2.54cm OD x 13.2cm). Cylindrical
profile.

Enclosure Finish

Anodized aluminum (blue).

Options:
-HN Male with Swivel Nut or HN Female.
-SHV Male or Female.
High Voltage Connector
-MHV Male or Female.
-Pigtails with HV cabling and HN, SHV, or MHV
terminations may also be provided.
Communication Connector Power over Ethernet
LED

Indicator LED (red) on rear panel.

Table 2: NPM3100E Mechanical Specifications

Figure 7. NPM3100E Device Dimensions.
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Figure 8. NPM3100E Rear Panel

Figure 9. NPM3100 side view.
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5.2 Electronic Specifications

Analog Components
High Voltage (HV)

0v (HV off) or 150V to 2,800V. RMS noise 0.010V. HV
level user adjustable. Step size 1V.

Charge Sensitive Amplifier Integrates input charge pulse and converts to voltage.
(CSA)
Sensitivity: 1V / pC or custom.
Pulse Shaping Electronics

Pulse shaping time constant 1s to 10s (consult
Quaesta when ordering). Pulse shaping decay time
10s to 100s (contact Quaesta Instruments to select)

Deadtime

Minimum Deadtime between successive counts, 15s to
100s. User selectable to 6000s maximum.

Neutron Counting Rate

100kHZ for 1s shaping time constant; 33kHz for 3s
shaping time constant, 10kHz for 10s shaping time
constant

Amplifier Electronics

User selectable gain range 1 to 20; 0.1 step size.

Table 3: Analog Components
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Digital Components
Microcontroller & Timer

ARM Processor

Nonvolatile memory

Up to 128Gb.

Analog-to-Digital
Converter (ADC)

12 bit

Temperature & Humidity
Sensor

Temperature: range -40C to 124C; resolution 0.01C;
accuracy +/- 0.1C. Humidity: range 0 to 100% RH;
resolution 0.03% RH; accuracy +/- 3%.

NPM3100U ONLY

TTL Input / Output available on NPM3100U only

TTL Output

Output TTL pulse triggers with neutron counts. 25ns to
16ms pulse width (user selectable).

TTL Input Mode 1

TTL Input Mode 2

Digital counter mode. NPM counts pulses on the TTL
input line and logs them independently from neutron
counts. 13ns pulse width minimum, 1MHz maximum.
Digital pulse feed through. NPM detects pulse on TTL
input and transmits a pulse on the TTL output line
independently from TTL output pulses corresponding to
neutron counts. For 'daisy chain' operation of NPMs.
13ns pulse width minimum, 1MHz maximum rate.

Table 4: Digital Components

Environmental
Operation
Temperature

-40C to +80C

Humidity

80%, noncondensing

Table 5: Environmental Operation
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6 Device Operation
The NPM3100 device is configured and controlled via a custom Command Set. Users
can interact with a NPM3100E device through commands issued from a computer using
(1) a terminal interface application such as Tera Term Pro or (2) custom interface
software interface such as a GUI application. A software interface, such as a GUI, uses
the same Command Set that the user can enter directly in a terminal window.
A detailed description of all device commands is found in 7. Device Command Set.
The Command Set interacts with the NPM in two primary ways:
1. Configuring or controlling the NPM by ‘writing’ device operational parameters.
2. Querying or reading device operational parameters or device data.

6.1 Interactive versus Autonomous Operation
Generally, the NPM may be operated either interactively or autonomously.
During interactive operation, a user will send commands to the NPM to configure,
control or read information from it. Interactive operation is possible using a terminal
interface or custom interface software, and presumes the use of a computer.
A user may also configure the NPM to operate autonomously, without only power
required.
Autonomous operation is often used in Unattended or Remote monitoring. If the NPM
is selected with the Datalogging option, the NPM can be configured to periodically
sample and record neutron counts, external TTL pulses (if using the NPM3100U
device), Temperature and Humidity, and Pulse Height spectrums. The periodic
recording of the Pulse Heigh spectrums allows the detector system health to be
monitored. Once the NPM is fully configured, it need not be connected to a computer
or external hardware device. The NPM only requires power, and it will log data
according to its instructions. Logged data can be stored on SD Card(s) for later
retrieval, and the device can operate independently in this fashion for an indefinite
period of time.
Autonomous operation of the Detector system to which the NPM is attached can also
be implemented through custom interface software or hardware which periodically
queries or controls the NPM. For example, Quaesta offers a hardware data logger
(model DL2100) that controls up to 16 Quaesta NPM devices. This data logger will
manage NPM configuration settings, automatically download and store data from
NPMs, transmit data via telemetry, and perform other functions.
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6.2 Standard Operational Parameters
The NPM has a variety of operational parameters that the user can both configure and
view using the Command Set. These parameters are stored in nonvolatile EEPROM
and are retained even when the device is turned off or rebooted.
Commands and parameters are not case sensitive.
Standard Operational Parameters include:
1. High Voltage: The high voltage value can be both written (or set) and read by the
Voltage command.
2. Maximum High Voltage: The maximum allowed high voltage value can be both
written and read by the MaxVoltage command. Of course, the maximum high
voltage setting cannot be greater than the maximum voltage of the high voltage
supply in the device, which is either 2000V or 2500V.
3. Gain: The gain value of the variable gain amplifier in the analog section of the
device can be both written and read by the Gain command.
4. Lower Discriminator: The value of the lower discriminator can be both written and
read by the Lowerdisc command. The lower discriminator value is given in terms of
bin number within the pulse height spectrum. The minimum lower discriminator
value is bin is 1/32 of the Number Of Bins (i.e., Bin 4 when the device is configured
with the Nbins parameter equal to 128), and the maximum value is equal to the
value of the upper discriminator minus one.
5. Upper Discriminator: The value of the upper discriminator can be both written and
read by the Upperdisc command. The upper discriminator value is given in terms of
bin number within the pulse height spectrum. The minimum upper discriminator
value is equal to the lower discriminator value plus one, and the maximum value is
equal to the maximum bin number in the pulse height spectrum histogram -1. i.e., for
Nbins = 128.
6. Number of Bins in Histogram: The number of bins in the pulse height spectrum
histogram may be both written and read by the NBins command. The histogram
can have the following number of bins: 64, 128, 256, 512, 1024.
7. Deadtime: The NPM is constantly scanning its input for pulses and comparing the
voltage of the pulse profile to the Lower Discriminator value. When a pulse contains
a voltage level higher than that corresponding to the Lower Discriminator value, the
NPM captures the waveform, measures its signal strength or pulse height, and, if it
is a valid neutron count, then it increments the digital counter value. While all of this
is happening, the NPM is not ready to receive another neutron signal pulse, and
subsequent neutron counts are ‘locked out’ and cannot be counted during this time.
This lockout time is referred to as the Deadtime of the device. The minimum
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Deadtime of the NPM varies across NPM models. For the NPM3100 series, the
user can configure the Deadtime to be any value from the minimum Deadtime of 15
usec to 6msec (6000usec). The Deadtime can be both written and read by the
Deadtime command.
8. Timing Resolution of Differential Arrival Time Spectrum: The Differential Arrival
Time Spectrum is a histogram of the arrival times of successive neutron counts.
This histogram is fixed at 1000 bins each with the same duration in time. Using the
DtRes command, the user can select or view the duration of these bins with allowed
Delta T resolutions of 1usec, 10usec, 100usec, 1000usec, and 10000usec. The
Differential Arrival Time Spectrum may be retrieved via the DtHgm command
9. Shaped Pulse Waveform Display Format: When a neutron shaped pulse
waveform is digitized in the ADC, this waveform is automatically output (streamed to
the output interface). The shaped waveform output by default has 256 points
(125nsec time spacing), which spans 32usec. The user can request the output
waveform or a subset of its 256 points. Using the PulseWave command, a number
of samples on the shaped waveform (as digitzed by the A/D converter) can be
displayed for the next incoming pulse.
10. Peakmode Display Format: Using the Peakmode command, the user can enable
Peakmode output, which displays summary information for each incoming pulse as
they arrive, including the neutron pulse count number and the assigned Bin # of the
Pulse in the accumulating Pulse Height spectrum. The Differential arrival time (time
since previous pulse) is also displayed in the text output. Peakmode is typically only
used for diagnostics and quick device setup.
11. Pulse Height Spectrum Histogram: The signal pulse height spectrum histogram is
accumulated and stored in memory by the NPM, and can be queried or retrieved
using the Hgm command. The format in which this histogram is displayed is
controlled by the HgmMode command. The number of bins utilized in the pulse
height spectrum histogram is configured through the Nbins parameter.
12. TTL Input and TTL Output: Some models of NPMs (such as the NPM3100U
serires) have the capability to output a proper TTL pulse when neutron pulses are
detected and/or external TTL input pulses are received. The external TTL Output
and TTL Input configuration can be controlled using the TTLMode and TTLWidth
prameters.
13. LED Mode: All NPM models have a signal LED on the rear panel that can be
configured to pulse with each valid neutron count; the LED may also be turned off.
Configuration of the LED is controlled by the LEDMode command.
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6.3 Data Logging Operational Parameters
The NPM has an optional internal data logging feature for all models. The user can
configure certain aspects of the data logging including the type of device data to be
logged and the time interval.
Data Logging Operational Parameters include:
1. Data Logging Record Interval: Under data logging, the user selects the time
period for which device data is logged. This logging time interval is called the
Record Period. The primary data logged in this interval is the neutron counts but
other quantities may also be stored. The Record Period can be configured and its
current setting displayed using the RecordPeriod command.
2. Logging the Pulse Height Spectrum: The pulse height spectrum can also be
logged. However, it is logged on a different time interval which is an integer multiple
of the Record Period. The reason for the different logging time intervals is that, quite
often, a user will find it convenient to log total neutron counts and the pulse height
histogram on different time scales, primarily because for low count rates, some time
is required to produce a well-defined spectrum. The command RecordsPerHGM is
used to specify the histogram logging time interval.
3. Sensor Data Logging: The NPM has an optional internal temperature and humidity
sensor. Data from this sensor may be included with or excluded from the logged
data using the commands LogTemp and LogHum.
4. Printing and Saving Logged Data: Data which is selected to be logged during the
RecordPeriod can be both printed to the device output and/or saved to the device
SD Card(s). The PrintDat and LogDat commands control whether or not logged
data is printed and/or saved.
5. Printing and Saving Pulse Height Histograms: The Histogram data which is
logged every user specified, integer multiple of the Record Period can be both
printed to the device output and/or saved to the device SD Card(s). The PrintHGM
and LogHGM commands control whether or not logged histograms are printed
and/or saved.
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6.4 Display of Operational Parameters
Any device operational parameter setting can be displayed by using its associated
command. However, the Info command automatically displays the settings of the most
common operational parameters as well as other useful device information. The Info
command is used, typically, in an interactive fashion from a terminal interface window
program such as Tera Term or Hyperterminal.
Note: the Command is not case sensitive.
The command Info yields a response from the NPM shown in Figure 10. General
information includes the device model number and version, serial number, firmware
version and a user selectable name for the device. The configuration settings for the
standard and data logging operational parameters are also displayed. The user may
quickly see, for example, the set values for high voltage, gain and lower discriminator.

Figure 10. INFO Command Output for the NPM3100U device
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Another command for displaying useful device information is the Menu command. This
command causes the NPM Command Set, with a brief explanation of each command,
to be printed to the device output in text format. This is not a detailed description of the
Command Set, but it is often useful as a quick reference during interactive operation of
the NPM.

6.5 Display of Data
Commands can be used to display device configuration parameters and also device
data, including things like the digital counter values, temperature and the pulse height
spectrum. Examples of data display in a terminal window are shown in Figure 11 and
Figure 12.

Figure 11. QUERY and TEMPERATURE Command Examples
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NU004 - Spectrum on GE 1in He3 10 atm Tube.
V=1400. G=5.5, NBins=64, DiscLow=7.
Source = Environmental Bkgnd Neutrons, Total Cts
= 811, Total Elapsed Time = 2950 seconds
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Figure 12. HGM (Histogram) Command and Output Example
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6.6 Outputs & Functions
The Outputs and Functions of the NPM3100 are discussed in more detail in this section.
6.6.1 Digital Pulse Waveform:
The shaped signal waveform is digitized by an ADC. Once a valid neutron count is
detected based upon the lower discriminator setting, the signal waveform is stored in
memory until a subsequent neutron is detected. The waveform is accessed by the
PulseWave command that causes the NPM to print the waveform to its output in text
format. The default digitized waveform consists of 256 data points with 125nsec
temporal spacing. The Pulse Waveform output does not operate asynchronously, but is
prompted only by a command. For some models, a GUI application is able to display
the shaped waveform.
6.6.2 Digital Discriminators:
A digital upper and lower discriminator may be specified by the user. These values are
given in terms of bin number which is related to the pulse height spectrum histogram.
The user specifies the number of bins in this histogram which spans the full dynamic
range, in voltage, of the amplifier output. For the lower discriminator, the minimum
allowed bin value is 1/32 of the Nbins value. The upper discriminator must be larger
than the lower discriminator. Generally, the NPM counts signal events between the
upper and lower discriminator values, inclusive of the end points. However, if the upper
discriminator is set to the maximum bin number or the maximum minus one, this
disables the upper discriminator, and all signal pulses equal to or greater than the lower
discriminator value are counted as valid neutron events. Set the Lower Discriminator
with the LowerDisc command and the Upper Discriminator with the UpperDisc
command.
Since the discriminators are digital, custom multiple regions of interest may be produced
by using multiple discriminators spanning different regions of the spectrum. This
requires custom device firmware. Call to discuss your specific application.

6.6.3 Digital Counter:
When a valid neutron count is measured, an internal digital counter is incremented (up
to > 4 billion counts). The counts command causes the device to output the number of
neutron counts and the associated elapsed time interval to its output. The accumulated
counts and accumulated elapsed time is zeroed. To query command outputs the
number of accumulated neutron counts and accumulated elapsed time without zeroing
the counts and elapsed time. The resolution of the timer associated with this feature is
1 second. This is not intended as a high temporal resolution digital counter. However,
higher temporal resolution can be achieved by utilizing the autonomous Datalogging
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feature of the NPM to periodically sample, internally record and/or output the NPM data
with precise timing controlled by the NPM’s internal high resolution timer. Additionally,
an external computer or control device with its own high resolution timer can periodically
query the NPM data utilizing an external computer or control device.
As an example of such an external control device, Quaesta makes a DL2100 series
data logger that will connect to certain Quaesta NPM devices, and can query and
timestamp neutron counts with its own high resolution timer.
6.6.4 TTL Output:
The NPM3100U has a TTL Output that can be configured to send out a TTL pulse with
each valid neutron count, or with each TTL pulse on the device’s TTL Input, or both.
The physical TTL Output line is a threaded female SMA connector on the rear panel of
the device. The TTL Output can be configured using the TTLMode and TTLWidth
command. The TTL Output may be turned off or on. And the length of the TTL pulse
may be selected The TTL Output has 50 ohm output impedance and is designed to
interface with digital pulse counters that have 50 ohm input impedance.
6.6.5 TTL Input:
The NPM3100U has a TTL Input that can measure TTL pulses from an external source.
The physical TTL Input is a threaded female SMA connector on the rear panel of the
device. This input can detect and count pulses at up to 20MHz rates. The input can be
configured to do nothing (off), to count external TTL pulses and log this information, to
trigger the TTL Output to transmit a TTL pulse with each TTL input pulse measured, or
both log and transmit external pulses. External TTL pulses with pulse widths from
25nsec to ymsec can be measured. The TTL input is 50ohm terminated.
6.6.6 Temperature & Humidity Sensor:
An optional temperature and humidity sensor may be installed in all NPM models as a
diagnostic tool for monitoring the device environment. Temperature and humidity
values may be queried upon command, and they may also be logged if the data logging
option is enabled with the device. The commands use to query this sensor are
Temperature and Humidity.
6.6.7 MCA: Pulse Height Spectrum:
The variable gain amplifier amplifies the shaped waveform. This analog waveform is
digitized into a user selectable but discrete number of levels or bins, settable through
the Nbins command parameter; allowed values of Nbins are 64, 128, 256, 512 and
1024 bins. A typical choice is 128 bins which provides for effective monitoring of the
Detector system health for most proportional neutron detector configurations. An
algorithm measures the signal strength or ‘pulse height’ of the digital shaped waveform
in units of bin number for each valid neutron count. The NPM has a multichannel
analyzer function which means it is able to store the number of neutron counts at each
signal strength or bin number. These count values for each bin are stored in an array
called the neutron pulse height spectrum, which is a histogram. This histogram can
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record over 4 billion counts per bin. The command nBins is used to specify the number
of bins in the histogram from the allowed list of discrete values. The command Hgm
prints the current histogram to the device output according to the histogram
configuration parameters specified in the HgmMode command.
The pulse height spectrum of a proportional neutron detector such as a Helium-3, BF3,
B-10 lined detector is an energy spectrum of the charge pulses developed in the
detector during a neutron detection event. However, this signal pulse height spectrum
does not reflect the actual energy spectrum of the neutrons themselves, that is, the
pulse height does not represent the kinetic energy of the neutrons being measured by
the detector. A proportional neutron detector or counter counts neutron detection
events and gives only count rate information; it is a not a neutron energy spectrometer.
However, the pulse height spectrum is an invaluable tool when working with
proportional neutron counters, allowing for easy setup and and continous monitoring of
the health of the detector system.
The device Pulse Height Spectrum Histogram provides for the following advantages.
a. Setup: Optimal configuration of a proportional neutron counter involves a few
important items: selecting the high voltage and gain such that the pulse height
spectrum is within the dynamic range of the amplifier and is well-defined;
selecting the lower and upper discriminators to maximize signal-to-noise by
counting all available neutrons and eliminating electronic noise and gamma ray
counts.
b. Diagnostics: Over time, the properties of the gas detector or electronics can
change which can lead to degraded performance. Moisture ingress, extreme
environments (cold, heat, vibration, etc) may affect the device operation. Device
degradation or failure will be evident in the pulse height spectrum, often before
the problem becomes severe. The ability to quickly and easily view the pulse
height spectrum is a valuable diagnostic tool to ensure proper operation of the
detector and electronics system. The diagnostic process can even by automated
by software that monitors changes in the shape of the spectrum. Pulse Height
spectrums can be logged internally on the NPM device for later retrieval and
review.
c. Ease-of-use: Without direct access to the underlying pulse height spectrum, that
is, without a multichannel analyzer, one must infer the configuration of the
detector. The most common method is the so-called ‘HV plateau’ method in
which the underlying pulse height spectrum is inferred by creating a graph of the
detector count rate versus the high voltage value for fixed gain and lower
discriminator settings. The plateau method can be very time consuming
especially for measuring low neutron fluxes and low count rate. Properly setting
up and optimizing detector operation is more straight forward and extremely easy
with the MCA capability. Detector systems can be realiably and repeatably set
up in a matter of minutes, with no radiation source.
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6.6.8 MCA: Differential Arrival Time Spectrum:
The NPM can measure the time between successive neutron counts and record these
times in a Differential Arrival Time Spectrum, or DT Histogram. The number of bins in
this DT histogram is fixed at 2048 bins. When a neutron count is measured, a timer is
initiated. This timer measures the time until the next neutron count. The measured time
is digitized into a discrete histogram with 1000 bins. The timing resolution of these bins
is configured by the user with the DtRes command and can have the values 1, 10, 100,
and 1000 usec. The differential arrival time spectrum is used in neutron coincidence
counting. . Since 1000 histogram bins are used in the Differential Arrival Time
histogram, the Differential Arrival Time Histogram spans differential arrival times of 1000
x the DtRes value. i.e. a DtRes of 10 usec will have DT bins ranging from 10 usec to
10000 usec (10 msec), and a DtRes of 10000 usec wave DT bins ranging from 10000
usec to 10,000,000 usec (10 seconds). Neutron pulses with Differential Arrival times >
1000 x DTRes will be accumulated in the highest Bin (i.e. Bin 999). The bins range
from 0 to 999.
Note: The timing reolution of Differential Arrival Times can be limited by the deadtime
or lockout time which refers to the shortest successive measurement interval of the
device. Typical deadtime for the NPM devices are on the order of 10 x the Time
Constant employed in the Charge Sensitive and Pulse Shaping Amplifier portions of the
NPM device. For a 3 usec shaping time constant – often used with 1 inch or smaller
diameter tubes, the Deadtime or Lockout time for the NPM is on the order of 30 usec.
This means pulses closer than 30 usec cannot be resolved. For larger diameter 2in or
larger tubes, a 10 usec shaping time constant is often used. In this case the Deadtime
or Lockout time is on the order of 100 usec. See Deadtime discussion.

6.6.9 Data Logging & List Mode Data Logging
The Data Logging and List Mode Data Logging functions are powerful features of the
3100 series NPMs. (Note that all NPM models offer data logging, but only the 3100
series products offer List Mode Data Logging).
Data Logging data is categorized into 3 data types: (1) DAT data, (2) HGM data and (3)
LST data. The following discussion includes information about and terminology
associated with these data types, their files and directories, and data logging in general.
6.6.9.1 DAT Data
1. DAT data is device data that is measured during a fixed, user specified, time
period and then recorded at the end of this recording time period.
2. The recording time period for DAT data is called the Record Period, and DAT
data is recorded at the end of every Record Period.
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3. The length in time of the Record Period is specified by the RecordPeriod
command.
4. When Data Logging is initiated, the NPM will measure and record the user
specified DAT data every Record Period, over and over, until it is directed to stop
or the device power is removed.
5. Which data is to be recorded as DAT data is somewhat user configurable.
a. Neutron counts are always included when DAT data is logged.
b. The real-time clock value (date & time) is always included when DAT data
is logged.
c. Temperature can be selected for logging.
d. Humidity can be selected for logging.
e. Supply Voltage can be selected for logging.
6. DAT data is stored in files called DAT files that have the .DAT file extension.
7. The Active DAT file is the one that the NPM is currently writing logged DAT data
to, continuously, every Record Period.
8. When a DAT file is created under the Data Logging function, it becomes the
Active DAT File, and it is given a name that is related to the real-time clock value
at the moment when the file is created. Later, the file may be renamed by the
user.
9. The Active DAT file is created at the beginning of a data logging sequence, and it
is assigned a file name associated with the real-time clock value at this moment.
10. DAT files are FAT 32 files.
11. DAT files are stored in a FAT 32 directory on the SD Card or Cards called the
DAT directory.
12. The DAT directory is created by the NPM if Data Logging is enabled. When the
NPM starts up, it searches the directories of the SD Card or Cards. If the DAT
directory is not present, then a DAT directory is created by the NPM.
13. NPMs with Data Logging enabled are shipped with SD Cards that have a DAT
directory. However, the user can delete the DAT directory from an SD. If the
device model contains an external SD card, the user can remove the existing SD
card and insert a new SD card. In such cases, upon start up, the NPM will
automatically create a DAT directory on its SD Card or Cards if it is not already
present.
14. The portion of DAT data written to a DAT file every Record Period is a called a
DAT Data Record. Every Record Period, a new DAT Data Record is appended
to the end of the Active DAT file.
15. The information contained in a DAT file is a file header, called the DAT File
Header followed by a series of DAT Data Records.
16. Data Logging can continue for a long time, and the DAT file can become large. A
new Active DAT file can be created after a user specified time interval, called the
New File Period, which must be longer than the Record Period. For, example, a
new Active DAT file can be created every day or longer.
17. The length in time of the New File Period is specified using the NewFilePeriod
command.
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6.6.9.2 HGM Data
1. HGM data is graphical, histogram data that is measured during a fixed, user
specified, time period and then recorded at the end of this recording time period.
2. The recording time period for HGM data is called the Histogram Period, and
HGM data is recorded at the end of every Histogram Period.
3. The Histogram Period must be an integer multiple of the Record Period and is
specified by the command RecordsperHGM.
4. When Data Logging is initiated, the NPM will measure and record the user
specified HGM data every Histogram Period over and over until it is directed to
stop or the device power is removed.
5. HGM data, which is not user configurable, includes (in order):
a. The current DAT Data Record.
b. The neutron Pulse Height Spectrum Histogram that has been developed
during the current Histogram Period.
c. Total histogram counts (summed over all bins) and total elapsed time (the
Histogram Time).
6. HGM data is stored in files called HGM files that have the .HGM file extension.
7. The Active HGM file is the one that the NPM is currently writing logged HGM
data to, continuously, every Histogram Period.
8. When an HGM files is created under the Data Logging function, it becomes the
Active HGM File, and it is given a name that is related to the real-time clock value
at the moment when the file is created. Later, the file may be renamed by the
user.
9. The Active HGM file is created at the beginning of a data logging sequence, and
it is assigned a file name associated with the real-time clock value at this
moment.
10. HGM files are FAT 32 files.
11. HGM files are stored in a FAT 32 directory on the SD Card or Cards called the
HGM directory.
12. The HGM directory is created by the NPM if Data Logging is enabled. When the
NPM starts up, it searches the directories of the SD Card or Cards. If the HGM
directory is not present, then a HGM directory is created by the NPM.
13. NPMs with Data Logging enabled are shipped with SD Cards that have an HGM
directory. However, the user can delete the HGM directory from an SD. If the
device model contains an external SD card, the user can remove the existing SD
card and insert a new SD card. In such cases, upon start up, the NPM will
automatically create a HGM directory on its SD Card or Cards if it is not already
present.
14. The portion of HGM data written to a HGM file every Histogram Period is a called
a HGM Data Record. Every Histogram Period, a new HGM Data Record is
appended to the end of the HGM file.
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15. The information contained in an HGM file is a file header, called the HGM File
Header, followed by a series of HGM Data Records.
16. Data Logging can continue for a long time, and the HGM file can become large.
A new Active HGM file can be created after a user specified time interval, called
the New File Period, which must be longer than the Histogram Period. For,
example, a new Active HGM file can be created every day or every week.
17. The length in time of the New File Period is specified using the NewFilePeriod
command.
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6.6.9.3 LST Data
1. LST data is device data that is recorded not based on a recording time period but
based on an event, a neutron count.
2. LST data is recorded every time a neutron count occurs for a user specified
maximum number of counts.
3. When List Mode Data Logging is initiated, the NPM measures and records LST
data for every neutron count event until List Mode logging is stopped or the user
specified maximum number of neutron counts is reached.
4. For LST data, which data types are to be logged, is not user configurable. Data
types includes (in order):
a. A label or tag that specifies the particular NPM from which the data was
generated.
b. The pulse height of each neutron counted.
c. A time stamp for the event.
5. LST data is stored in files called LST files that have the .LST file extension.
6. The Active LST file is the one that the NPM is currently writing logged LST data
to, continuously, during the List Mode Data Logging session.
7. When an LST file is created under the List Mode Data Logging function, it
becomes the Active LST File, and it is given a name that is related to the realtime clock value at the moment when List Mode Data Logging is finished. Later,
the file may be renamed by the user.
8. LST files are FAT32 files.
9. LST files are stored in a FAT32 directory on the SD Card called the LST
directory.
10. The LST directory is created by the NPM if Data Logging is enabled. When the
NPM starts up, it searches the directories of the SD Card. If the LST directory is
not present, then an LST directory is created by the NPM.
11. NPMs with List Mode Data Logging enabled are shipped with an SD Card that
has an LST directory However, the user can delete the LST directory from an
SD. If the device model contains an external SD card, the user can remove the
existing SD card and insert a new SD card. In such cases, upon start up, the
NPM will automatically create a LST directory on its SD Card or Cards if it is not
already present.
12. The portion of LST data written to a LST file after every neutron count is a called
an LST Data Record. For every neutron detection event, a new LST Data
Record is appended to the end of the Active LST file.
13. The information contained in an LST file is simply a list of LST Data Records in
sequential order. The LST file has no file header.
14. List Mode Data Logging does not operate continuously. When List Mode Data
Logging is finished, the Active LST file is closed.
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6.6.9.4 Data Logging Procedure
The Data Logging function records user selected device data. The NPM has a real-time
clock and battery that will keep proper time even when the device is not powered. To
log data, the user must:
1. Ensure the date and time settings of the device are correct. If not, they can be
set using the Time command.
2. Select the data logging timing using the RecordPeriod command. If the Record
Period is one hour, then the number of neutron counts and the temperature
during this interval, for example, are recorded every hour.
3. Select the Histogram Period for logging the pulse height histogram.
4. Configure the Data Logging function to record the desired data, and ensure data
to be logged has the desired format. The user chooses the data to be recorded
such as neutron counts and temperature.
5. Data Logging is initiated by selecting DAT or HGM data to be printed to the
output, saved on SD card(s) or both. The DAT and HGM data records are
independently specified with respect to printing and saving.
Once data logging is initiated the NPM will operate independently and record data
according to its configuration. The NPM does not need to be connected to a computer.
However, printing data to its output will not be of use if the NPM is not connected to an
external device to receive the data. In any case, the NPM can log data to its SD card(s)
for later retrieval. SD card data can be accessed and downloaded via the NPM when
connected to a computer.
Both DAT and HGM data types are stored in FAT32 file format in a directory on the SD
card(s), each in their own subdirectory. The user can view and manipulate the file
structure with familiar commands such as dir (show directory), cd (change directory),
and Del (delete).

6.6.10 List Mode Data Logging Procedure
List Mode is another data logging function, however, in List Mode the NPM is able to
time stamp each individual neutron count rather than logging measured values within
specified time windows. The data recorded in this mode for each neutron count is:
a. Pulse height (digitized in 2048 bins)
b. Time of count (500nsec resolution)
c. NPM identifier tag (for array applications with multiple NPMs)
When Logging data in List Mode:
1. The user first specifies the number of Pulses to be logged in ListMode using the
ListMax command.
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2. Acquisition is initiated by the ListMode=1 command, and will continue
automatically until the specified number of pulses have been recorded or the
ListMode=0 command is entered to stop acquisition, whichever comes first.
3. Data acquired is stored as binary data to the internal SD Card in FAT32 file
format in a directory named LST. The data file generated is given a name
related to the date and time (taken from the real-time clock) during file creation.

Logged files in directories DAT, HGM and LST can all be read directly from the SD
Card(s). List Mode Logging is available for the 3100 series NPMs which have only an
internal SD card which is not physically accessible by the user. So, List Mode data
must be read from the SD Card through the NPM device itself. The ListView command
allows the user to download a List Mode data file and to select the format of the
downloaded data in text, hexadecimal or binary formats.
The ListStatus command will report the current pulse number in the LIstMode
acquisition sequence.
More information about the Data Logging and List Mode functions is available in section
7, the Device Command reference section. More information about the directory and
structure of all logged data is given in section 6.7, Data Logging: Directory Structure,
Data Format and SD Card Storage.
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6.7 Data Logging
6.7.1 Directory and File Structure for NPM
NPM3100 devices have an internal SD card that is not removable by the user. If the
Data Logging of List Mode Logging option is enabled for any NPM, an SD Card and a
real-time clock battery is included.
For NPM models that come with an external SD card slot, if the user inserts a new
(properly formatted) external SD Card into the device, the NPM will automatically create
its standard directory structure on the new card when it powers up for the first time with
the new card.

NPM3100 devices with Data Logging enabled have 3 primary directories for storing
logged data. These are called DAT, HGM and LST.
The internal SD card is designated by 0: and the external SD card (if applicable) is
designated by 1:. Access to the file system is provided through commands similar to
the PC DOS file and directory management commands, i.e., ‘dir’,’cd’,’0:’,’1:’,’getcwd‘,
etc.
Displaying a directory of the internal SD card will appear similar to Figure 13.

Figure 13. File Directory Structure

The NPM has 3 types of data that it records under its Data Logging and List Mode
Logging functions. These are DAT, HGM and LST data types, and the files that store
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them are referred to as DAT, HGM and LST files, respectively. Each data type is stored
in its own directory in the Standard Directory for Logged Data.
6.7.1.1 Data Types
DAT files are used to store DAT data, in text format. For DAT files to be saved to the SD
Card during data logging, the LogDAT configuration parameter must be set to 1
(LogDAT=1). See
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DAT Directory and File Contents, section 6.7.2.
HGM Files are used, primarily, to store histogram (graphical) data, in text format. The
data logging configuration, and the duration of data logging will determine both the size
and number of histogram graphs stored in a single HGM data file. For example, if Nbins
has been set equal to 1024, then each histogram will have 1024 data points. The
format of the histogram data is also user specified. It can include just 1024 bin counts
that are printed in the order of ascending bin number. Or the histogram data can
include data pairs with the histogram bin number followed by its associated neutron
count value separated by a comma. See examples of histogram data format in Figure
14. For HGM files to be saved to the SD Card during data logging, the LogHgm
configuration parameter must be set to 1 (LogHgm=1). See HGM Directory and File
Contents, section 6.7.3.
Data Logging for DAT or HGM files will begin whenever the parameter LogDAT or
LogHGM is set equal to 1, and logging will cease if these parameters are set equal to 0.
Device parameter settings are stored in nonvolatile EEPROM and are saved when
powering down and recalled when powering up. When the device powers up, if either
parameter is already set equal to 1, then DAT or HGM files will be created and data
logging will begin immediately for the associated data type. If both are set to 1 on
power up, then their file names will be very similar since the file name involves the realtime clock value at the time of creation of the logging file. Of course, they will have
different file extensions, .DAT and .HGM.
LST files are used to store LST data in binary format. The size of the LST file is
determined by the neutron count rate and the length of time for which LST logging is
allowed to proceed. Generally, file size is predetermined by the number of neutron
counts selected for logging if it is allowed to proceed to completion. However, LST
logging can be terminated early by the ListStop command. See LST Directory and
File Contents, section 6.7.4).
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Figure 14. Histogram Format Types
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6.7.2 DAT Directory and File Contents
The user can view the Directory of DAT files stored on SD Card(s) using the NPM’s
directory command, Dir (Figure 15).

Figure 15. DAT Directory Example.
The latest DAT file created in the example in Figure 15 as the name
‘NPM1_130701.DAT’. The NPM1 prefix is a user specified name that can be given to a
particular NPM. The 130701 indicates the date of file creation, July 1, 2013.
The DAT directory contains files with time series of recorded data in text format. A
generic text header with NPM parameter configuration information is written at the top of
each file (Figure 16). The last line of this generic file header contains the date & time,
data record number (Index) and the column headers or titles for the data that is to be
logged in the file. For example, the column title ‘Cnts’ applies to the data column
containing neutron counts. If data logging has been configured to record temperature,
then a column with the title ‘DegC’ will be present, and so forth. When logged DAT data
is recorded each Record Period, it is appended to the active DAT logging file each time.
Figure 17 shows the Datalogging Parameters portion of the DAT file header with
annotations.
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Figure 16. DAT File Example.
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Figure 17. Data Logging Parameters in File Header with Annotations
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The contents of the NPM1_130701.DAT can be viewed by using the Type command
(Figure 16). The Type command followed by the file name prints the full contents of the
file to the output in text format.
The DAT file header includes NPM device information, standard and data logging
parameter configurations, date & time and data column titles in the last row of the file
header. Note that much of the header is similar to the output of the Info command used
to query the NPM for basic device information and current configuration parameters.
Column titles indicate that neutron counts, temperature and humidity are all being
logged. In the example in Figure 16, five DAT data records (indexes 73 – 77) have
been appended to this DAT file after the header. This indicates that 5 Record Periods
have elapsed since data acquisition began.
Since the NewFilePeriod parameter is set for 1 day, then at the beginning of each new
day, a new DAT file will be created with a name associated with the date of the day on
which it is created. This new file will become the active data logging DAT file and DAT
data will be appended to this file every Record Period until yet another active DAT
logging file is created on the following day, and so forth.
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6.7.3 HGM Directory and File Contents
The HGM directory contains HGM files with a time series of histogram data in text
format. The user can view the Directory of HGM files stored on SD Card(s) using the
NPM’s directory command, Dir (Figure 18).

Figure 18. HGM Directory Example.
The latest HGM file created has the name ‘NPM1_130701.HGM’. The NPM1 prefix is a
user specified name that can be given to a particular NPM. The 130701 indicates the
date of file creation, July 1, 2013.
The histogram data is the neutron pulse height spectrum for the gas detector.
A generic text header with NPM parameter configuration information is written at the top
of each file (Figure 19). This is exactly the same as the header in the DAT files. The
last line of this generic file header contains the date & time, data record number (Index)
and the column headers or titles for the DAT data that is to be logged in the DAT file.
For example, the column title ‘NPM_Cnts’ applies to the data column containing neutron
counts. If data logging has been configured to record temperature, then a column with
the title ‘DegC’ will be present, and so forth. When HGM data is recorded every user
selected Histogram Period, this data is appended to the HGM file after the header.
The contents of the NPM1_130602.HGM can be viewed by using the Type command
(see Figure 20). The Type command (within the HGM directory) followed by the file
name prints the full contents of the file to the output in text format. The HGM file header
includes NPM device information, standard and data logging parameter configuration,
47

NPM3100 Operation Manual and Specifications
Quaesta Instruments LLC

October 12, 2018

date & time and data column titles in the last row of the file header. Note that much of
the header is similar to the output of the Info command used to query the NPM for basic
device information and current configuration parameters. Column titles indicate that
neutron counts, temperature and humidity are all being logged in the active DAT file.
Since the NewFilePeriod parameter is set for 1 day, then at the end of the current day, a
new HGM file will be created with a name associated with the date of the day on which
it is created. This new file will become the active data logging HGM file and HGM data
will be appended to this file every Histogram Period until yet another active HGM
logging file is created on the following day and so forth.
The actual histogram data is appended to the HGM file after the header. Each
Histogram Period includes, in order (see Figure 19 and Figure 20):
1. The current DAT record at the time of writing the HGM data.
2. The histogram in the selected format.
3. The total number of neutron counts in the histogram and the acquisition time for
the histogram in seconds.
After each Histogram Period, the HGM data record with these 3 elements is appended
to the file sequentially. Including the Current DAT record may be useful in cases in
which a user wants to know the device parameters such as humidity and temperature
for which a particular histogram was collected.
The HGM file header contains useful information. Under the Logger Parameters
section, the user can see which file types are being printed or saved, and which DAT
data is being logged. The Record Period for logging DAT data is displayed along with
the number of Record Periods per logging of HGM data. Note that the Histogram
Period is the time between logging of HGM data. And the Histogram Period =
RecordsperHgm x RecordPeriod in seconds. In Figure 19, the Record Period is 60
seconds and the Histogram Period is 60 Record Periods or 3600 seconds (1 hour). So,
in this example, a new HGM data record is appended to the active HGM file every 1
hour.
The New File Period configured by the NewFilePeriod parameter command indicates
how often a new, active HGM file is created while logging HGM data. For example, this
might happen once a day.
The Current Time parameter indicates the real-time clock value for which this particular
HGM file was created. Since the date and time are used to create the file name, this
value will be evident in the file name.
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Figure 19. HGM File Example.
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Figure 20. HGM Data Printed with Type Command To Terminal

Histograms are sampled and written in a format selected by the HgmMode parameter
and the nBins parameter (section 0). In the example in , the histograms are displayed
in two columns. Column 1 is the histogram bin number and column 2 is the total counts
in that bin for the current Histogram Logging Period.
A recorded histogram can be plotted (Figure 21). In this example, the shape is that of
a textbook Helium-3 spectrum and indicates that the detector tube and electronics are
behaving normally. See Helium-3 Detector Spectra, section 8.1.
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Figure 21. Helium-3 Detector HGM (Pulse Height Spectrum)
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6.7.4 LST Directory and File Contents (for ListMode datalogging)
The LST directory contains files with time series of recorded data that can be viewed in
a user selectable format: text, hexadecimal or binary.
The user can view the Directory of LST files stored on the internal SD Card using the
NPM’s directory command, Dir (Figure 22).

Figure 22. LST (ListMode Data) Directory Example

The List Mode data file does not contain a header as the DAT and HGM files do. The
LST files contain only the List Mode data. Unlike data logging of DAT and HGM data in
which the data file is created before data acquisition, for List Mode data logging, the List
Mode data is acquired, and then at the end a file is created. The name of the file is
associated with real-time clock value at the time of file creation.
For every Pulse, List Mode data includes the pulse height, the time and a tag that
identifies the particular NPM with which the data was acquired. The ListView command
reads LST files from the internal SD card of the 3100 device and prints it in the user
selected format to the output. An example of List Mode data format is given in Figure
23, where the ListView command was used to display the ListMode data.
The first column is just a label for the data record, and the following 3 columns are the
data. Each data record or row corresponds to a single neutron detection event. In text
format, the data is 3 comma delimited numbers. The first number identifies the NPM
with which the data was taken. This can be used to tag a detector within an array. The
second number is the measured pulse height for the data record digitized into 2048
parts. The third number is the time in seconds. While the timing resolution shown in
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Figure 3 is 125nsec, the modern generation of NPM3100 devices has a timing
resolution of 500nsec

Figure 23. List Mode Data viewed with the ListView Command.
6.7.4.1 List Mode Data Format
Each binary LST file consists of a series of 8 byte LST data records..
LST Record
Byte
Number
0-4

Data Type

5

Unsigned

6-7

Unsigned

Unsigned

Data
Timestamp, in units of 100 nanoseconds
NPM Identifier, useful when arrays of NPMs on
detectors are used
Pulse Amplitude

Table 6: LST Data Format (Binary format)

All data is in Little Endian byte order, i.e. Least Significant Byte is first. The binary list
mode record format cannot be changed by the user. i.e., the number of bytes in each
pulse record will always be 8 bytes. Contact Quaesta Instruments if a custom LST data
record format is desired.
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6.8 Device Interface
An NPM3100 user has several options for communicating with the device through its
communcations interface.
1. A Quaesta Instruments GUI allows for viewing and setting of Device parameters.
Contact Quaesta or visit http://www.quaestainstruments.com.
2. A Terminal Emulation application program such as Tera Term Pro or Windows
Hyperterminal may be used to interactively interface to the NPM. This is
accomplished via the Windows Virtual COM port.
3. The user may write his own RS232 interface application for communicating with
the device.

6.8.1 Terminal Interface NPM3100U
6.8.1.1 NPM3100U Terminal Interface Communication
The NPM3100U interface will present itself in Windows as a Virtual COM port, i.e., USB
Serial Port. See Ctrl Panel -> Device Manager, as in Figure 24. The ‘Ports’ section
will list the NPM3100U interface as a USB Serial Port. Older Windows versions
(Windows XP) may need to download and install FTDI drivers from the FTDI website
(http://www.ftdichip.com/Drivers/VCP.htm).
After the Virtual COM port (COM 12 in Figure 24) is assigned by Windows, PC
applications can communicate to the NPM3100U device a standard RS232 interface
device.
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Figure 24. Device Manager and COM Port Assignments

NPM3100U COM Port Settings:
Baud Rate: 115200
Data Bits:
8
Parity:
NO Parity
Stop Bit:
1
Flow Control: None
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6.8.1.2 NPM3100U Teraterm Pro Terminal Configuration
Tera Term Pro is a very good, freely available Terminal Interface program which can be
used to interface directly to the NPM3100U device. Other terminal interface programs
which provide for RS232 connectivity can also be used, such as Windows
Hyperterminal or PuTTY. Settings similar to those described for Tera Term Pro should
be used.
The latest version of Tera Term Pro can be downloaded from:
http://ttssh2.sourceforge.jp/index.html.en
After install, the Tera Term Pro window of the form in Figure 25 will appear as in

Figure 25. Teraterm Pro Main Window.
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Open a new connection (File->New Connection), as in Figure 26 and select the USB
Virtual COM port corresponding to the attached NPM3100U device.

Figure 26: Virtual COM Port Selection
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Configure the Terminal through the menu Setup-> Terminal. See Figure 27. The Newline configuration Transmit option must be set to CR+LF. Other suggested
configuration options are shown in Figure 27 as well.

Figure 27: Terminal Window Configuration
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Configure Tera Term’s Serial Port settings through the menu Setup -> Serial Port.
(See Figure 28).
Serial Port Settings are: 115200 baud, 8 Data bits, No Parity, 1 Stop Bit, and No Flow
Control.

Figure 28: Serial Port Settings
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6.8.2 Terminal Interface NPM3100E
6.8.2.1 NPM3100E Network Configuration
Knowledge of the NPM3100E device IP address is required in order to make the first
connection to the NPM3100E device. By default, all NPM3100E devices ship with an IP
address in the 192.168.15.XXX address range. The NPM3100E IP address at the time
of shipping is provided on a removable label affixed to the device. The default factory
TCP port # is 10001.

.

Note: Both the device IP address and the TCP port are configurable
by the user.
Caution should be used when changing the IP address and/or TCP
port # of the NPM3100E device as the device can become
unreachable.
For Directions on configuring the NPM3100E IP address, See
6.8.2.3 Searching for an NPM3100E device
A Quaesta Instruments “QIDeviceDiscovery” GUI Application is
available which can be used to search for NPM3100E devices
accessible through an Ethernet user’s network.

The GUI allows the user to discover devices, set IP addresses, and
The following
stepsfirmware.
can be used when making a direct connection to the NPM3100E,
Upgrade
bypassing
any larger
area network.
Contact
Quaesta
Instruments for details.
The Description of this Software is in Progress.
Step 1. A Power Over Ethernet (POE) switch or adapter is required in order to power
the NPM3100E
device
properly
and provide
Ethernet
connectivity.
See Figure 29.
Configuring
the
NPM3100E
IP Address
and TCP
Port # after
connecting to the device.
Step 2. Configure the PC to use an IP address in the same subnet as the NPM3100E.
Details:
Windows 7 Settings
Open "Network and Sharing Center" from the Control Panel “Network and
Internet Window”. See Figure 30 and Figure 31.
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Figure 29: Power Over Ethernet (POE) Connection Configurations

Figure 30: Control Panel Network and Internet
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Figure 31: Network and Sharing Center
Select the Local Area Connection as found in the Network panel of Figure 31. A Local
Area Connection Status window of the form shown in Figure 32 will be displayed.

Figure 32: Local Area Connection and Status Window
Select the Properties command button and then “Internet Protocol Version 4
(TCP/Ipv4)” on the Local Area Connection Properties window. See Figure 33.
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Figure 33: Local Area Connection Properties Window
Select the “Properties” command button of Figure 33 to arrive at a TCP/Ipv4
properties Window as in Figure 34. Select the “Use the following IP address
radio button.”
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Figure 34: TCP/IP Properties Configuration.
Configure the IP address with an IP address on the same subnet as the NPM3100E
device. Figure 34 shows the PC configured to have an IP address of 192.168.15.100
and a subnet mask of 255.255.255.0.
NPM3100E devices by default ship with IP addresses in the 192.68.15.XXX range, and
thus will be able to communicate with a PC configured as in Figure 34 here.

6.8.2.2 NPM3100E Terminal Configuration
The NPM3100E device can be accessed via a Terminal interface application.
Suggested applications include Tera Term Pro and PuTTY, both freely available
applications.
Quaesta recommends Tera Term Pro which can be downloaded at
http://ttssh2.sourceforge.jp/index.html.en.
If using a Tera Term Pro version later than version 2.3, the user should edit the Tera
Term.ini file (found in the Tera Term Pro installation directory) and set the parameter
EnableLineMode=off. This will allow characters to be transmitted and echoed back from
the device as the characters are typed. If EnableLineMode=on, the terminal program
will buffer the characters until a CR is entered, at which time the entire line of data will
be sent to the NPM.
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On Windows 7 machines, the Tera Term.ini file is generally located by default in the
install directory “C:\Program Files (x86)\TeraTerm2” directory.
The Tera Term.ini file can be edited via a text editing program such as Notepad.
Search for “EnableLineMode” and set to OFF, as indicated below in Figure 35Figure
35.

Figure 35. Teraterm INI File Setup

After launching the Teraterm Pro application, a simple main window as shown in Figure
36 may appear.
Select File->New Connection to make a new connection and open a window of the form
shown in Figure 37.
Select a TCP/IP connection and type in the NPM3100E device IP address.
Type in the TCP port# for the NPM3100E device (The default factory configured
NPM3100E TCP port # is 10001).
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Figure 36: Tera Term Pro Main Window

Figure 37: Tera Term Pro TCP/IP Configuration

From the main Tera Term Window, select the menu Setup-> Window. You can set the
title and the number of lines in the Scroll Buffer, as in Figure 38.
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Figure 38. Teraterm Terminal Window Setup

Again from the main Tera Term Window, select the menu Setup-> Terminal
Allowing the Tera Term window to be resized is convenient (Tera Term=win size).
Set the New-line conditions as in the GUI window (Figure 39). Terminal ID is VT100.

Figure 39: Tera Term Pro Terminal Setup
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6.8.2.3 Searching for an NPM3100E device
A Quaesta Instruments “QIDeviceDiscovery” GUI Application is available which can be
used to search for NPM3100E devices accessible through an Ethernet user’s network.
The GUI allows the user to discover devices, set IP addresses, and Upgrade firmware.
Contact Quaesta Instruments for details.
The Description of this Software is in Progress.
6.8.2.4 Configuring the NPM3100E IP Address through the Terminal Interface

The NPM3100E device IP Address and TCP/IP Port # are both configurable via a
TCP/IP Terminal interface application.
Directions for making first-time TCP/IP connections to the NPM3100E device and for
configuring Tera Term Pro can be found in sections 6.8.2.1 and 6.8.2.2.
Default factory shipped NPM3100E device IP addresses lie in the range
192.168.15.XXX and the default factory shipped NPM3100E device TCP/IP Port# is
10001.
To change the IP address or configure the TCP/IP Port#, first make a connection to the
NPM3100E device. Note that after making IP address or TCP Port #’ changes, these
changes will not take effect until the NPM3100E device is rebooted or power cycled.
Current operating and configuration parameters can be displayed using the info
command, as in Figure 40.
Figure 40 This will show the current IP address and TCP Port #.
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Figure 40: Terminal output of ‘info’ command

Setting the NPM31000E IP Address
To change the IP Address, type IPAddress = XXX.XXX.XXX.XXX where
XXX.XXX.XXX.XXX is the chosen new IP Address. Since changing the IP Address can
make the device unreachable if the user misplaces or loses this IPAddress, the
NPM3100E device will respond with a query to make sure you want to change the IP
Address. You must type YES (in capital letters) in order for the IP Address to be
reconfigured. If YES is typed in response, then the NPM3100E device will record the
newly desired IP Address in EEPROM.
Implementation of the new IP Address will not occur until power cycle or reboot of the
NPM3100E device.
Example:
ipaddress=192.168.15.102
You are sure you want to change the IP Address to:
192.168.15.102 ?
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If yes, record the new IP Address and enter 'YES'
YES
New IP Address will take effect after Reboot
192.168.15.102
Changing the NPM31000E TCP Port #
Note: The user is strongly recommended to make notes of any changes to
the NPM3100E TCPPort and other network settings. Certain settings can
make the device unreachable via TCPIP. In such cases the user is
recommended to make use of the Quaesta Instruments
QIDeviceDiscoveryTool GUI.
Changing the NPM31000E TCPPort used for TCPIP communication can make it
significantly more difficult to search for and find an NPM3100E device on the network if
the IPAddress information or TCPPort information is lost by the user.

6.8.3 Graphical User Interface (GUI)
6.8.3.1 Windows GUI Application
A Windows graphical user interface (GUI) software package is in development for
Communication with NPM3100E and NPM3100U devices.
6.8.3.2 NPM3100E Web Browser GUI
The NPM3100E has a built-in web browser interface that can be used within common
web browser tools such as Firefox or Chrome. To access the Web Interface, go to
http://XXX.XXX.XXX.XXX where XXX.XXX.XXX.XXX is the device’s IP address. Make
sure the device is reachable from your PC. Contact your network admiistrator if you
need help viewing, setting, and/or understanding your PC’s network settings such as
the Subnet Mask and Gateway settings.

6.8.4 RS232 (Virtual COMPort) Interface
Users may write their own interface application for communicating with and controlling
Quaesta Instruments’ NPM3100U devices through use of the Windows Virtual COMPort
funcitionality. The NPM3100U device can then be interfaced with software making use
of standard RS232 interface functions. The Command Set is made available in this
User Manual with a complete description of each command. Quaesta staff are
alsoavailable for technical support in this regard.
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FTDI USB Driver Support

Users may also communicate directly with the NPM device via FTDI’s driver. Example
code can be provided. Contact Quaesta Instruments for details.

6.9 Array Applications
6.9.1 NPM3100U
The NPM3100U has a TTL Input and a TTL Output which are accessed via two SMA
connectors on the rear panel of the device.
The TTL Input can be configured to:
1. Log input pulses from an external device along with neutron events measured
internally.
2. Generate a TTL pulse on the TTL Output whenever a pulse is measured at the
TTL Input. (The input TTL pulse is transmitted directly through to the TTL Output
line).
3. Or both
The TTL Output can be configured to transmit a TTL pulse whenever a neutron is
counted by the device. Thus, the TTL Output line may transmit pulses whenever the
NPM measures a neutron pulse (internally) or whenever it measures a TTL pulse at its
TTL Input.
The ability of the NPM to transmit external pulses allows it to be used in array
applications in a common ‘daisy-chain’ configuration (Figure 41). A series of NPMs is
connected via their TTL Input and Output lines. The TTL Output of one NPM is
attached to the TTL Input of another NPM in a series. The result is that all neutron
counts at every NPM in the array are transmitted along a single line. This line could be
connected to an external digital counter. Or the final NPM in the line could act as a
digital counter and data logger for the entire array.
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Figure 41. NPM3100U Array Application.

6.9.2 NPM3100E
The NPM3100E device includes features intended for array applications including List
Mode data acquisition and external clock synchronization capabilities. Each
NPM3100E in an array can measure and time-stamp neutron events with 500nsec
resolution. Since the internal clocks among an array of NPMs do not operate with
exactly the same frequency, then timing among the devices in an array can become
increasingly less accurate over time. For example, if two clock frequencies are different
by one part per billion, then in 500 second, the relative time between the clocks will
differ by 500 nanosecond. Thus, in 10s of minutes of time, the clock error will surpass
the 500nsec timing resolution capability of the NPMs.
This precision timing issue is resolved by permitting all NPMs in an array to operate off
the same external clock. In this mode of operation, all NPMs stay perfectly
synchronized even over long time periods. The NPM3100E is able to receive an
external clock signal on its Power over Ethernet connector. Quaesta supplies a
hardware device, the ES3100, designed to interface between a standard POE switch
and an array of NPMs. The ES3100 injects a clock pulse onto the POE line which is
inserted into each NPM. The external clock pulse perfectly synchronizes all NPMs in
the array. See Figure 42.
For array applications, the NPM3100E can operate using an external clock. Quaesta’s
ES3100 array synchronization tool interfaces between a POE switch and an array of
NPMs. It injects a clock pulse on the POE line, and this clock pulse is used to
synchronize the timing across the array. NPMs in this configuration can produce List
Mode data and maintain 500nsec timing resolution over indefinite time periods.
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Figure 42. NPM3100E with Array Time Synchronization
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7 Device Command Set
A thorough description of the NPM3100U Command Set is included in this section.
Commands are sent to the NPM in text format via either the Ethernet interface
(NPM3100E devices) or USB interface (NPM3100U devices). Commands should be
terminated with a Carriage Return or a Carriage Return + Linefeed character sequence
(i.e. CR or CR+LF). NPM3100 output issued as a result of these commands will be
returned as text via the same interface.
Terminal emulators such as Tera Term Pro or Windows Hyperterminal can be
configured to communicate with NPM3100E devices via TCPIP or NPM3100U devices
via USB. Configuration of these terminal emulators is covered in section 6.8.
Alternatively GUI applications provided by Quaesta Instruments can be utilized to
communicate with the NPM3100 devices. The GUI applications make use of the basic
NPM3100 series interface commands identified in this section.
General Command Set notes:
Commands are not case-sensitive (i.e. they are case-insensitive).
The device Command Set includes three general types of commands:
C
R
R/W

– Control Commands
– Read Commands
-- Read/Write Parameter Commands (i.e., the parameter is both readable
and writeable)

Control commands can be activated by simply typing the name with any required
arguments, i.e. ‘reboot’.
Read parameters and commands can be queried by simply typing the name (i.e.,
‘Gain’).
Write parameters can be written or set by using an equal sign (i.e. ‘Gain=3.8’).
All commands must be terminated with a Carriage Return + Linefeed (CR + LF)
sequence.
Command descriptions are organized by functionality and “subsystem” in the following
subsections.
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7.1 Miscellaneous Device Commands and Parameters
Command Quick Reference Table
Name

Type

Name
Menu
Help
Info
Sdev
Uptime
Reboot

R/W
R
R
R
R
R
C

Operation
Name of the NPM device
Report all available commands
Report all available commands
Report device identification and parameters
Noise Standard Deviation
Seconds since device startup
Reset the system

Table 7: Miscellaneous Commands

Name

R/W

The user assigned name of the NPM device

Each NPM can have an unique Name assigned by the user. The Name can consist of a string
of alphanumeric characters and is limited to 16 characters. Entering "Name" without an
argument will display the current Name.
Example:
Name= NPM_Unit#1
NPM_Unit#1

Menu

R

Display a list of all user availabe commands

The Menu command causes a (nearly complete) list of device commands to be Printed to
the device output.

Help

R

Display a list of all user availabe commands

Identical to the Menu command.
See section D.1 NPM3100U Menu Command Output for an example of the Help (Menu)
command output.

Info

R

Report device identification and parameters
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Provides the Firmware Version, Model, Model Version, and Serial Number, followed by a
list of the current NPM operating parameters. An example of the output is shown below.
Quaesta Instruments, LLC
www.QuaestaInstruments.com
Firmware Version
X.1.0.1
Model
NPM3100
Model Version
ETH
Serial Number
NE0001
Name
NPM_Unit#1
Identifier
1
***Neuchrometer PARAMETERS***
Voltage Set
1450
Voltage Measured
1450.1
MaxVoltage
2100
Gain
3.0
DiscLow
10
DiscHigh
127
DeadTime
50
PeakMode
0
LEDMode
1
PulseSim(uS)
0
nBins
128
HgmMode
2
DtResolution
100
***LOGGER PARAMETERS***
RecordPeriod(Sec) 60
NewFilePeriod
Day
RecordsPerHGM
5
PrintDAT
0
PrintHGM
0
LogDAT
0
LogHGM
0
LogTemp
1
LogHum
1
ListSectors
5
Current Time
2015/02/20,13:06:12
***NET CONFIGURATION***
IP Address
= 192.168.15.101
SubNet Mask
= 255.255.255.0
Default Gateway = 0.0.0.0
MAC
= 2-0-0-0-0-1
TcpPort
= 12000
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Noise Standard Deviation

Sdev is typically used by Quaesta factory personnel during initial device testing to test the
electronic noise floor level of the NPM device. Sdev rapidly samples the ADC output of the
Analog input electronic chain. A burst of 4096 samples is acquired and the RMS value of
the ADC readings is reported, along with the max ADC value and the mean ADC value.
Using Sdev=N will acquire N bursts of 4096 samples and average the Sdev results over the N
bursts. Note that the noise floor of the device will depend on the gain.
Example:
For Gain=20
sdev=100
NoiseRMS=

12.162

NoiseMAX=

22

NoiseMEAN= -5

The Sdev result can be converted to MCA Histogram Bin numbers. The noise floor Bin can
be calculated approximately by using the formula
(Noise Floor Bin#) = NoiseMax *(nBins/2048)
where nBins is the number of bins used in the MCA histograms. In the example above, the
Noise Floor Bin# is approximately Bin 2 for nBins=128.

Uptime

R

Number of seconds since device startup.

Reports the number of elapsed seconds since device startup.

Reboot

C

Reboot (restart) the system firmware.

Reboot the system firmware. The firmware will reset, and the device will then start up
just as it does after a Power Cycle sequence. The reboot sequence begins immediately, at
which time the Firmware bootloader begins. The bootloader will run for 10 seconds
during which time a series of question marks will be printed to the output. When loading
new firmware, upload must be initiated within this time frame.
Note that any TCP Port connections, including Web Browser connections, will be
disconnected after a Reboot command. Thus the user will have to reconnect to the device
after the Reboot if it has an Ethernet interface.

77

NPM3100 Operation Manual and Specifications
Quaesta Instruments LLC

October 12, 2018

7.2 NPM Commands and Parameters
The NPM commands and parameters described in this section are parameters specific
to the Neutron Pulse Module electronics operation.

Command Quick Reference Table
Name

Type

Operation

Voltage

R/W

MaxVoltage

R/W

Gain
DiscLow or
LowerDisc
DiscHigh or
UpperDisc
DeadTime
PeakMode
PulseWave
LEDMode
Counts
Query
Cps
ZeroCounts
TTLOutMode
TTLOutWidth
TTLCounter
TTLCounts
TTLQuery
ZeroTTLCounts
PulseSim

R/W

High Voltage Supply value in Volts (250 to MaxVoltage)
Maximum allowed High Voltage (0 to HV range maximum,
Model version specific, ie NPM3100E-2.5kV)
Amplifier Gain (1.0 to 20.0)

R/W

Lower Discriminator (Neutron Pulse Threshold)

R/W

Upper Discriminator

R/W
R/W
R/W
R/W
R
R
R
C
R/W
R/W
R/W

Pulse detection dead-time or “lockout” time (sec)
Pulse peak display mode - not typically used (0 or 1)
Display waveform of the next received pulse
LED activation mode (0 or1)
Report and zero the total neutron pulse counts
Report the total neutron pulse counts without zeroing
Report the counts per second
Zero the neutron pulse counter
Configures the TTLOut Feedthrough of TTLInput
TTLOutput pulse width for Neutron Generated Pulses
Disables and Enables the external TTLInput counter (0 or 1)
Display and Zero the TTLInput counter and elapsed time
Display and Not Zero the TTLInput counter and elapsed time
Zeroes the TTLInput counter and elapsed time
Pulse Simulation Period in usec

R
R
C
R/W

Table 8: NPM Commands

Voltage

R/W

High Voltage Supply value (Volts).

Each NPM has an internal high voltage power supply which can be set to any Voltage
between 250 Volts and 2000 Volts. The Voltage is set with an integer value and is regulated
to a precision of 0.1 Volt. Entering a Voltage greater than the MaxVoltage parameter is not
allowed and will result in the Voltage being set to MaxVoltage. Entering "Voltage" without
an argument will display the currently measured voltage and the desired Voltage .
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Example:
voltage=1300
1300
The voltage will ramp slowly to the new voltage (typically will take approximately 20
seconds for voltage to ramp from 0 to 1000V and stabilize):

voltage
Measured/Set: 1300.1/1300

MaxVoltage

R/W

Maximum Allowed High Voltage

The MaxVoltage parameter is a safeguard which helps prevent accidentally setting the
Voltage to a level higher than would be considered safe for the neutron detector tubes
being used with the NPM. For example, perhaps the user desires to experiment with a
variety of voltages when using a particular tube, but wishes never to exceed a maximum
voltage. MaxVoltage can be set to the maximum allowable voltage that is recommended for
the tube. Entering "MaxVoltage" without an argument will display the current MaxVoltage
value.
Example:
MaxVoltage= 1800
1800

Gain

R/W

Amplifier Gain.

The neutron pulse module amplifier Gain can be set to any value between 1.0 and 20.0
with a resolution of 0.1. Typically, the Gain will be set according to the requirement for a
particular detector tube. A Gain producing pulse heights of roughly 75-80% of the full
scale range of the amplifier is often ideal for most applications. For example, if the Nbins
parameter is set to 128, the user may desire to select a Gain that causes the majority of
pulses to produce peak heights of approximately 100. The pulse heights can easily be
observed in real-time by setting PeakMode=1. Alternately, the pulse height histogram can
be viewed to determine the height of the majority of the pulses. Entering "Gain" without an
argument will display the current Gain value. Note that changing the High Voltage will also
introduce gain into the electronic system. The appropriate Gain value will thus also depend
on the HV value.

Example:
Gain= 5.7
5.7
Gain
5.7
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LowerDisc
Or

R/W

Neutron Pulse Detection Lower Threshold

DiscLow
The DiscLow or LowerDisc discriminator value determines the pulse height (in histogram
Bin numbers) below which a pulse is not counted. This is typically used to filter out gamma
ray pulses or low level electronic noise. The units of DiscLow are in bin numbers. So for
example, if Nbins=128 then a DiscLow value of 32 would prevent pulses that have a height
of less than 25% (32/128) of full scale from being counted. Entering DiscLow without an
argument will display the current DiscLow value.
Example:
DiscLow= 30
30
DiscLow
30

UpperDisc
or

R/W

Neutron Pulse Detection Upper Threshold

DiscHigh
The DiscHigh or UpperDisc parameter prevents pulses with heights above a threshold level
(in histogram Bin numbers) from being counted. The units of DiscHigh are in bin numbers.
For example, if Nbins=128, then a DiscHigh value of 120 would prevent pulses that have a
height greater than 93% (120/128) of full scale from being counted. This can be used to
eliminate coincident events or spurious noise pulses which can have exceedingly large
pulse heights.
The Maximum value of the DiscHigh parameter is (Nbins-1). If set to the maximum value,
the Upper Discriminator is disabled and full scale (saturated ADC) pulses will be registered.
Entering "DiscHigh" without an argument will display the current UpperDisc value.
Note on Histogram reporting:
The UpperDisc parameter filters pulses with amplitudes greater than the UpperDisc
value from being recorded in the total counts parameter. However, the UpperDisc
parameter does not affect the recorded histograms. i.e, when an UpperDisc value is set,
the recorded Histogram will still tally counts in bins higher than this value. This is
done so that users can still observe and monitor the overall pulse height distribution
and monitor high amplitude pulses even when the user does not want to count them.
High amplitude pulses can be an indicator of spurious counts or high voltage
breakdown in the detector tube, connector, or NPM electronics.
Example:
DiscHigh= 125
125
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Neutron pulse detection “lockout” time

The DeadTime parameter specifies the minimum time interval or “lockout time”, in
microseconds, during which two consecutive pulses can be detected. DeadTime can
sometimes be useful for screening out semi-coincident pulses wherein two briefly spaced
pulses occur due to a single common event. For example, if an event is known to cause
multiple counts to be generated within a specific time period, the DeadTIme parameter can
be adjusted to a value equal to or greater than this time period as a way to eliminate the
secondary pulses. For current generation devices, the smallest allowable DeadTime is 30us
for units with pulse shaping Time Constants of 3usec and the longest allowable DeadTime
is 6000us. This corresponds to maximum counting rates of 33kHz and 167 Hz
respectively. Entering "DeadTime" with no argument displays the current value.
Note: DeadTime in neutron counting devices is sometimes referred to as a “Lockout Time.”
Example:
DeadTime= 2000
2000

PeakMode

R/W

Pulse peak display mode.

PeakMode provides a method for observing peak pulse height information about individual
detected neutron pulses as they occur, in real-time. If PeakMode is set to a value of 1, only
the pulse height (peak of the pulse) information is displayed. Entering "PeakMode"
without an argument will display the current PeakMode value.
Example:
PeakMode= 1
1
A typical pulse peak-height summary, with a 128 bin histogram, might look similar to the
following:
Cnt=31482,Max=1109,Pos=12.4,Bin= 69,DeltaT=49,Time=4.673388750,455ff000b2468fe

-

where:
Cnt is the number of accumulated counts since last Counts or ZeroCounts command
Max is the Pulse maximum height (peak height) in ADC bits. Full scale analog
measurements are 2048 bits.
Pos is the location in ADC Sample # after the pulse detection threshold (DiscLow or
LowerDisc) is crossed
Bin is the MCA Bin # corresponding to the value Max. This can be calculated as
Floor(Max/(2048/nBins) where nBins is the number of MCA bins.
DeltaT is the number of DTRes intervals since the last pulse
Time is the number of elapsed seconds since activating PeakMode (setting
PeakMode=1)
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Pulse waveform output mode.

If a PulseWave command is issued, the peak-height information (as displayed in the
PeakMode command) is followed with data representing the pulse shape. The analog
pulses are bi-polar and the pulse-shape data are integers ranging from -2047 to +2047,
with a value of 0 representing the quiescent state of the amplifier output.
The full command syntax is PulseWave=N,F
where
N= # of waveform points to print.
F= Output format
Examples:
PulseWave=32,0
Max=1413,Pos=10.62,Bin=
598
750
903
1031
1135
1221
1290
1340
1376
1401
1411
1413
1404
1387
1363
1332
1296
1253
1210
1161
1107
1052
994
936
877
815
755
694
631
568
508
447

88,Cnt=9474190,Time=1071.020001125,DeltaT=19999,5850109f982bb2d

Pulsewave=32,1
Max=1415,Pos=10.63,Bin=88, Cnt=9792270,Time=7432.640001125, DeltaT=19999,587014538cb702d
599,750,907,1032,1135,1223,1291,1341,1378,1401,1413,1415,1405,1389,1364,1333,1297,1255,12
09,1160,1107,1052,994,935,877,815,755,695,631,569,507,446
Pulsewave=32,2
Max=1414,Pos=10.63,Bin= 88,Cnt=9796863,Time=7524.500001125,DeltaT=19999,586014613ce552d
0
598 751 904 1032 1135 1221 1290 1341 1377 1402 1413 1413 1406 1388 1363 1334
16
1297 1256 1210 1160 1106 1053 994 936 876 815 755 693 631 570 507 446
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LED Activaton Mode

LEDMode= 1, the red LED on the back of the NPM3100E will momentarily flash whenever a
pulse is detected.
LEDMode= 0, the LED flash is suppressed.
Entering LEDMode without an argument will display the current LEDMode value.
Example:
LEDMode=0
0
LEDMode
0

Counts

R

Display and Zero the Neutron Pulse Counter

Displays the number of pulses counted and Elapsed Time since the last "Counts" command
was issued or since the last "ZeroCounts" command was issued. The neutron counts value
is set to zero following the display of the current value.
Example:
Counts
143,79
 143 counts were tabulated over a 79 second interval. The counts and

timer are zeroed after the command.

Query

R

Display the Neutron Counter Without Zeroing

Displays the number of pulses counted since the last "Counts" command was issued or
since the last "ZeroCounts" command was issued. The "Query" command does not zero the
neutron counts value.
Example:
Query
1956,257
 1956 counts have been tabulated over a 257 second interval. The counts

and timer are not zeroed.

Cps

R

Display the Neutron Counts Per Sec

Displays the current Counts per Second calculation, (calculated every second)
Example:
Cps
223
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Zero the neutron pulse counter

Zeroes the neutron counts and elapsed time timer value in the NPM’s internal digital
counter. Returns 0 when complete.
Example:
ZeroCounts
0

TTLOutMode

R/W

Configures the Feedthrough State of TTL Input

TTLOutMode may have a value of 0 or 1.
TTLOutMode=0 will disable the feedthrough of TTL Input pulses to the TTL Output.
TTLOutMode=1 will enabled the feedthrough all TTL Input pulses straight to the TTL
Output. i.e. 5 usec wide TTL input pulses will be directly fed through as 5 usec wide output
pulses.
Example:
TTLOutMode=1
1
TTLOutMode
1

TTLOutWidth

R/W

TTLOutput Width for Neutron Generated Pulses

TTLOutWidth sets the TTLOutput pulse width in nanoseconds for Neutron generated
pulses.
TTLOutWidth may have values of 0, 25, 50, 100, 200, 500, 1000, 2000, 5000, and 10000
nanosecsonds.
TTLOutWidth=0 will disable the TTLOutput for Neutron generated pulses.
TTLOutWidth=25 will result in the production of 25 nsec wide TTLOutput pulses for each
Neutron generated pulse.
Examples:
TTLOutWidth=2000
2000
TTLOutWidth
2000

2 usec wide TTLOut pulses will be produced for each Neutron generated
pulse detected

TTLCounter

R/W

Turns On and Off the counting of TTLInput pulses

TTLCounter=0 turns OFF (diables) the counting of TTLInput pulses.
TTLCounter=1 turns ON (enables) the counting of TTLInput pulses.
Example:
TTLCounter
2000
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Display and Zero the TTLInput Pulse Counter.

Example:
TTLCounts
4989,1245
 4989 TTLInput pulses counted during a 1245 second interval.

TTLQuery

R/W

Display but do Not Zero the TTLInput Pulse Counter

Example:
TTLQuery
3190,4560
 3190 TTLInput pulses counted during a 4560 second interval.

ZeroTTLCounts R/W

Zeroes the TTLInput Pulse Counter.

Immediately zeroes the TTLInput pulse counter. Returns a value of 0 when complete.
Example:
ZeroTTLCounts
0

PulseSim

R/W

Pulse Simulation Period.

The NPM3100 allows for internally generated pulses to be fed into the Analog signal chain.
This can be used to verify the operation of the electronics and the counting system.
The user may enter PulseSim=N where N is the period between pulses in microseconds.
Note: The Analog input
Allowed values of N (microsec) are:
0=OFF, 50000, 20000, 10000, 5000, 2000, 1000, 500,200,100
Corresponding,respectively, to pulse rates of:
0Hz, 20Hz, 50Hz, 100Hz, 200Hz, 500Hz, 1000Hz, 2000Hz, 5000Hz, 10000Hz
The PulseSim function typically generates pulses approximately 80% of Full Scale when the
NPM Gain is set to 3.0.
Example:
PulseSim=20000
PulseSim Period =

20000 us

This will result in simulated pulses internally generated at a rate of 50Hz.
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7.3 Multichannel Analyzer (MCA) Commands and Parameters
Command Quick Reference Table
Name

Type

Operation

Hgm

R

Report the histogram according to HgmMode

MaxHgm

R

Report histogram maximum information

ZeroHgm
HgmMode

C
R/W

Nbins

R/W

Zero the histogram
Histogram output format (1,2,3)
Number of Bins used in the integrated Multi-Channel
Analyzer histograms

Table 9: Multichannel Analyzer Commands

Hgm

R

Displays the MCA histogram

Displays the currently accumulated pulse height spectrum or histogram according to the
format specified by the HgmMode parameter.
Example:
With Nbins=64
Hgm
0,0
1,0
2,0
3,0
4,0
5,0
6,0
7,5
8,2
9,3
10,3
11,2
12,12
13,20
.
.
.
.
43,27
44,27
45,25
46,34
47,47
48,57
49,68
50,80
51,59
52,44
53,3
54,0

NU004 - Spectrum on GE 1in He3 10 atm Tube. V=1400.
G=5.5, NBins=64, DiscLow=7.
Source = Environmental Bkgnd Neutrons, Total Cts = 811,
Total Elapsed Time = 2950 seconds
90
80
70
60
50
40
30
20
10
0
0

10

20

30

40

50

60

70
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55,0
56,0
57,0
58,0
59,0
60,0
61,0
62,0
63,2

Total=811,2950

MaxHgm

R

Display histogram maximum value information

Reports postion of histogram maximum, maximum value, and total histogram counts.
Can be useful as a quick monitor of Detector and electronic performance and status.
Example:
MaxHgm
50,80,811

Displays the position of histogram maximum in Bin numbers, maximum value of the
histogram (in number of counts), and the total number of counts in the histogram.

ZeroHgm

C

Clears the NPM pulse height histogram

Zeroes or Clears the neutron pulse module histogram recorded by the integrated
Multichannel Analyzer. Returns 0 when zeroing is completed.

HgmMode

R/W

Reported Histogram format mode

The HgmMode parameter specifies the format in which the histogram is displayed
following an Hgm command.
HgmMode= 1 , the histogram consists of a single column with Nbins number of rows. Each
row contains the number of pulse counts that have been placed in the corresponding bin
number.
HgmMode= 2 , the histogram is displayed in a similar manner to HgmMode=1 except that a
prefixed column is added which specifies the bin number for each histogram value.
HgmMode= 3 , the histogram is displayed in a similar manner to HgmMode=1 except that
the histogram values are scaled such that the histogram peak has a value of 255. This is
useful for normalized graphical representations of the histogram. Since the Pulse Height
spectrum is a property of the Tube and the operating parameters, the shape of the curve
should be independent of the total tounts accumulated (ignoring Poisson statistical
fluctuations).
In all cases, the histogram is followed by the total number of counts represented in the
histogram and the total number of seconds that have elapsed, since the histogram was last
zeroed with the ZeroHgm command. Entering HgmMode without an argument will display
the current HgmMode value.
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Example:
HgmMode=2
2

Nbins

R/W

Number of MCA Histogram Bins

Specifies the number of bins, or resolution, of the pulse-height histogram recorded by the
integrated Multichannel Analyzer (MCA). Allowed values for Nbins are: 64, 128, 256, 512,
and 1024. Any other value will be rejected. Entering "Nbins" with no argument displays
the current value.
Example:
Nbins= 128
128
Nbins
128
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7.4 Delta-Time Histogram (Differential Arrival Time Spectrum)
Commands
Command Quick Reference Table
Name

Type

Operation

DTRes

R/W

Delta-Time resolution (microsec)

DTHgm

R

Report Delta-T Histogram

ZeroDTHgm

C

Zero the Delta-T Histogram

Table 10: Differential Arrival Time Spectrum Commands

DTRes

R/W.

Delta-Time Resolution (sec)

Example:
DTRes=1000
1000
DTRes
1000

The current resolution in microsec for the Delta-T Pulse Arrival Time spectrum. Each bin
in the histogram represents a DTRes width of time and indicates the number of pairs of
pulses which have arrived in that DeltaT interval. Pulse pairs with Delta-T Pulse Arrival
times greater than 1000*DTRes will be tabulated in the highest bin, i.e. Bin 999.
Entering “DTRes” with no argument displays the current value.
Allowed values of DTRes are 1, 10, 100, 1000, and 10000 usec.

DTHgm

R.

Report the Delta-T Histogram

Reports the DeltaT Histogram.
The DeltaT Histogram is 1000 bins in size, and is reported as columns of (N*DTRes),
followed by the number of pulses in that DT interval, i.e. Bin 8 will contain the number of
pairs of pulses which arrived in the DeltaT time interval spanning (8*DTRes) and
(9*DTRes).
Pulses with differential Pulse Arrival times greater than 1000*DTRes will be tabulated in
the highest bin, i.e. Bin 999.

ZeroDTHgm

C

Clears the Delta-T Histogram

Zeroes or Clears the DeltaT Arrival Time spectrum internally recorded.
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7.5 Sensor Commands
Command Quick Reference Table
Name

Type

Temperature
Humidity

Operation

R
R

Temperature and Relative Humidity
Temperature and Relative Humidity

Table 11: Sensor Commands

Temperature

R

Report Temperature and Relative Humidity

Report Temperature and Relative Humidity, Comma Separated, i.e.
T, RH
Example:
temperature
28.7,35.5
The temperature is 28.7 C and the Relative Humidity is 35.5%

Humidity

R

Report Temperature and Relative Humidity

Report Temperature and Relative Humidity, Comma Separated, i.e.
T, RH
Example:
humidity
28.7,35.5
The temperature is 28.7 C and the Relative Humidity is 35.5%
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7.6 Data Logging Commands
Command Quick Reference Table
Name

Type

PrintDAT
LogDAT
RecordPeriod
NewFilePeriod
Time
LogMode
ShowFilenames
PrintHGM

R/W
R/W
R/W
R/W
R/W
R
R
R/W

LogHGM

R/W

RecordsPerHGM

R/W

LogTemp
LogHum
LogTTLCounts

R/W
R/W
R/W

Operation
Print Data Record to Terminal each Recordperiod
Save Data Record to SD Card each Recordperiod
Data Sampling period, in seconds: >= 3 seconds
NewFile creation period: Day, Month, Year
Report or Set Time and Date
Report Current Data Logging settings
Report Active DAT and HGM Filenames
Print HGM to terminal each Recordperiod
Save HGM to SD card according to
RecordsPerHGM and Recordperiod parameters
Number of Records between Sampled and Zeroed
HGMs
Log Temperature in each Data Record
Log Humidity each Data Record
Log TTLInput Counts

Table 12: Data Logging Commands

PrintDAT

R/W

Print data each RecordPeriod (0 or 1)

Turns OFF/ON printing of data to the output each RecordPeriod
0 = OFF; 1= ON.
Example:
PrintDAT=1
1

LogDAT

R/W

Save data to SD cards each RecordPeriod (0 or 1)

Turns OFF/ON the saving of text formatted data to the SD cards each RecordPeriod 0 =
OFF, 1= ON.
Example:
LogDAT=1
1
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RecordPeriod R/W Data recording interval in seconds
Specifies the number of seconds between the sampling of data records. Minimum allowed
value is 3 seconds.
Example:
RecordPeriod= 60
60

NewFilePeriod

R/W

Interval for New File Creation

Specifies the period of time between which new files will automatically be created.
Allowable periods are the words: Day, Month, and Year.
Example:
NewFilePeriod = Day
Day

Time

R/W

Date and Time (i.e. 2012/05/08 14:35:22)

Date and Time in YYYY/MM/DD HH:MM:SS format.
Example:
Time=2012/07/09 15:24:00
2012/07/09,15:24:00
Waiting 20 seconds and then querying:
Time
2012/07/09,15:24:20

LogMode

R

Reports the current Logger parameters

Reports the current Datalogger parameters.
Example:
logmode
PrintDAT
LogDAT
RecordPeriod
NewFilePeriod
PrintHGM
LogHGM

=
=
=
=
=
=

0
1
60
Day
0
1
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RecordsPerHGM = 60
LogTemp
= 1
LogHum
= 1

ShowFilenames

R

Report active DAT and HGM filenames

Report the currently active DAT and HGM filenames.
Example:
LogDAT=1
LogHGM=0
showfilenames
DAT FileName = /DAT/IP173_1301180000.DAT
HGM FileName : Not Saving Histogram

PrintHGM

R/W

Print histogram data periodically (0 or 1)

Turns OFF/ON the periodic reporting of the Multichannel Analyzer Histogram data to the
terminal. 0 = OFF, 1= ON.
When PrintHGM=1 histograms will be sampled and reported to the terminal every
(RecordPeriod * RecordsPerHGM) seconds.
Example:
PrintHGM=0
0

LogHGM

R/W

Save histograms to SD cards periodically

Turns OFF/ON the periodic recording of the Multichannel Analyzer Histogram data to the
SD cards. 0= OFF, 1= ON.
When LogHGM=1 histograms will be sampled and recorded to the SD cards every
(RecordPeriod * RecordsPerHGM) seconds.
Example:
LogHGM=1
1
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Number of data recording intervals between sampled
histograms

The RecordsPerHGM parameter specifies the number of records that must occur for each
histogram. RecordsPerHGM can have a minimum value of 1 record per histogram. Entering
RecordsPerHGM without an argument will display the current RecordsPerHGM value.
Example:
RecordsPerHGM = 60
60
Note: If RecordPeriod = 60 and RecordsPerHGM=60, then Histograms would be sampled
every 60 minutes, or once per hour.

LogTemp

R/W

Include Temperature in Data Records

Turns OFF/ON the inclusion of Temperature in the data sampled each RecordPeriod. 0 =
OFF, 1 = ON. Requires Sensors option.
Example:
LogTemp=1
1

LogHum

R/W

Include Humidity in Data Records

Turns OFF/ON the inclusion of Relative Hunidity % in the data sampled each RecordPeriod.
OFF = 0, ON = 1. Requires Sensors option.
Example:
LogHum=1
1

LogTTLCounts R/W Include Exernal TTL Input Counts in Data Records
Turns OFF/ON the inclusion of External TTL Input Counts in the data sampled each
RecordPeriod. OFF = 0, ON = 1. Requires Sensors option.
Example:
LogTTLCounts=1
1
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7.7 File system Commands and Parameters
7.7.1.1 File system Overview
The NPM collection of commands for handling and working with files has been
implemented to match closely the analogous Microsoft DOS operating system
commands. There are one or two Secure Digital memory cards, one internal (0:/) and,
in some models, one removable external (1:/) and both memory cards are formatted
with the FAT32 file system. There are three specific directories located in the root of
the SD card(s), the DAT, HGM and LST directories.
Upon startup, the NPM3 creates these directories if they don't already exist. It also
conditionally creates new files based on the unit's name and the date and time.
As in DOS, one can change to a file's directory in order to access the file or one can
enter the file's entire path in order to access the file from any other directory. For
instruction purposes, this manual assumes that the file of interest is located in the
current working directory.

Command Quick Reference Table
Name

Type

Operation

Dir
GetCwd
DiskInfo
FileInfo A.B
Type A.B
Cd A

R
R
R
R
R
C

0: or 1:

C

Copy A.B X.Y
Rename A.B X.Y
Attrib ?? A.B
Del A.B
MkDir A
Format

C
C
C
C
C
C

Report files in directory
Reports the current working directory
Report bytes free and size of SD cards
Report File Information
Print to the output the File A.B
Change directory to A
Set current disk to 0: or 1: (NPM3100 series has only
0: internal card)
Copy file
Rename file
Set or change attributes of a file.
Delete a file.
Make a new file directory
Format the 0: internal SD card. Caution!

Table 13: Filesystem Commands
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List of files in the active file directory

Entering ‘Dir’ without an argument will display the contents of the current working
directory. Entering "Dir" with a pathname will display the contents of the directory
specified by the path.

GetCWD

R

Report the current working directory

Retrieve the current working directory location.

DiskInfo

R

Report SD card bytes free and SD card Size in bytes

FileInfo

R

Report file information (as output in ‘Dir’ command)

Reports file information for a single file as reported by the ‘Dir’ command.
Example:
fileinfo ip173_1205210000.dat
----A 2013/01/20 11:13
38669 ip173_1205210000.dat

Type

R

List the contents of a file

List the contents of a file.
Entering “type” without an argument will list the entire contents of a file.
One may also list a specified portion of the file, either a the beginning (Head) of the file or at
its end (Tail). The number of blocks (512 bytes each) to be listed is specified with an
integer.
Example 1:
To retrieve the entire contents of a file:
Type File1.xyz
To retrieve the first 1024 bytes of a file:
Type File1.xyz Head 2
To retrieve the last 4096 bytes of a file:
Type File1.xyz Tail 8

Cd

C

Change the active directory
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This command will behave like the PC based DOS ‘cd’ command.
Entering ‘cd’ without an argument will behave as the ‘getcwd’ comand and will return
current working directory location.
Entering ‘cd’ followed by a directory name or a path to a directory on the active drive will
change the current active working directory to the specified location
Example:
cd 0:/HGM
0:/HGM
Entering ‘cd’ followed by a directory name or a path to a directory on a different drive will
change the default active directory on the different drive. i.e., if the active directory is
0:/HGM and the user enters ‘cd 1:\HGM’ the active working directory will remain 0:/DAT,
but when the user subsequently enters ‘1:’ the active working directory will become
1:\HGM.
Example:
getcwd
0:/DAT
cd 1:/HGM
0:/DAT
1:
1:/HGM External SD Card
cd
1:/HGM

0: or 1:

C

Select internal (0:) or External (1:) SD Cards

‘0:’ will make the active SD card the internal SDcard.
‘1: ‘ will make the active SD card the external SDcard.

Copy

C

Copy a file

Copy a file to another filename and/or location.
Example 1:
Copying a file from the current working directory to the SD card DAT
directory.
Copy File1.xyz 0:/DAT/File1.bak

Rename

C

Rename a file

Changes the name of a file.
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Example:
Rename File1.xyz Name1.abc

Attrib

C

Set attributes of a file

The ‘Attrib’ command can be used to change the Read-only and Archive attributes of a file.

Del

Example1:
Attrib +R File1.xyz

(Make the file be Read-Only)

Example2:
Attrib -R File1.xyz

(Remove the Read-Only flag)

Example3:
Attrib +A File1.xyz

(Set the Archive flag)

Example4:
Attrib -A File1.xyz

(Remove the Archive flag)

C

Delete a file or files

The ‘Del’ command can be used to delete a file from the current or other directory.
Example:
Del 1:/HGM/File1.xyz
Wildcard deletes are also allowed.
For example, all files ending with .xyz can be deleted from a directory
with:
Del *.xyz
All of the files in a directory can be deleted with:
Del *.* or Del *.
Example:
Del 1:/HGM/*.hgm

Mkdir

C

Create a new directory

Creates a daughter directory.
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Example:
mkdir temp
OK

Format

C

Format the Internal SD card (use with Caution)

Allows complete erasure and formatting of the internal SDcard. This command should be
used with care because all data on the card will be lost.
Example of Internal SD card format:
0:
0:/DAT Internal SD Card
format
You are requesting to Format, 0: Internal SD Card
If you are sure you want to do this enter: Y.
Otherwise just hit return.
Y
Please wait....
Done formatting, 0: Internal SD Card
0:
0:/ Internal SD Card
getcwd
0:/
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7.8 Listmode Commands and Parameters
Command Quick Reference Table
Name

Type

Operation

ListMode

R/W

Turns Off/On (0/1) ListMode data logging

ListMax

R/W

Number of ListMode records (pulses) to log

ListStatus
ListView

R
C

ListStream

R/W

ResetTime

C

Current ListMode data record number.
Convert binary ListMode data file to Text or Hex rep
Real-Time Streaming of ListMode events to TCPIP
port… No Logging. 0->Off, 1-Text, 2-Hex Rep, 3Binary
Resets ListMode timestamp timer.

Table 14: Listmode Commands

ListMode

R/W

Turns Off/On (0 / 1) List Mode Logging of Data. Data is
saved in binary format, 8 bytes per data record.
0 -> Will stop ListMode datalogging.
1 -> Will activate ListMode datalogging (acquisition of
ListMax records)
Example:
ListMode=1

ListMax

R/W

Read or Write the number of Records to beacquired during
ListMode datalogging (i.e. when ListMode=1)
Example:
ListMax = 100000
ListMode=1

ListStatus

R

Return current record number

ListView

R

Convert binary ListMode data file and send out on TCPIP
Port. If a terminal program is being used, this will display
converted data on the terminal.
Options:
Start - The starting record number
End - The ending record number
Hex - Output data in Hexadecimal Format.
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Stream real-time ListMode records to the TCPIP Port. If a
terminal is being used, this will result in real-time display on
the Terminal
0 -> Stops ListMode streaming.
1 -> Streaming in Text format.
2 -> Streaming in Hexadecimal character format.
3 -> Streaming in Binary format. Best if a PC acquisition
program is directly acquiring data.
Example 1:
Incoming periodic detector pulses with Peak Pulse
Height of 47 and cadence of 500 usec
(0.0005 seconds) are streamed in Text format
ListStream = 1
Output:
48,0.112600000
48,0.112800000
48,0.112999900
48,0.113200000
48,0.113400000
48,0.113599900
…
…
Example 2:
Incoming periodic detector pulses with Peak
Pulse Height of 47 and cadence of 500
usec (0.0005 seconds) are streamed in Hex
format.
ListStream = 2
Output:
305f6000066ef90
305f6000066f75f
306f6000066ff30
306f60000670700
305f60000670ecf
305f600006716a0
Where
305 -> (hex chars 13-15) is Decimal 773, is the Peak
Amplitude on a scale of 0-> 1024
f6 -> (hex chars 11-12) is Decimal 246, the Device
identifier number
hex chars 1-10 is a 40 bit number
corresponding to the Timestamps in
increments of 100 nsec (0.1 usec)
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7.9 Network Parameters
The commands in this section apply to NPM3100E devices which provide an Ethernet
interface.

Command Quick Reference Table
Name

Type

Operation

IPAddress

R/W

NetMask

R/W

Device IP Address. Be careful when changing this
value. Record the newly set IP Addr. Will become
active after device reboot or power cycle
Subnet mask, i.e. 255.255.255.0

GatewayAddress

R/W

Gateway Address

Table 15: Network Commands

IPAddress

R/W Active IP Address of the device
Allows the NPM3100E user to set the IP Address.
Use with caution and record the new IP address!
Note: A new IP Address will only become active after the new IP Address has been set and
accepted by the device. A device reboot will then be required to begin using the new IP
Address.
Example: Set IP Address of device to 192.168.15.20
ipaddress=192.168.15.20
You are sure you want to change the IP Address to: 192.168.15.20 ?
If yes, record the new IP Address and enter 'YES'
YES
New IP Address will take effect after Reboot
192.168.15.20

Netmask

R/W

Subnet mask, i.e., 255.255.255.0

Allows the user to change the Subnet mask.

GatewayAddress

R/W

Gateway Address.
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Allows the user to change the Gateway Address on the device. This will be ignored as the
device does not autonomously send data or connect to the Internet.

8 The Value of the Pulse Height Spectrum
The NPM3100 series integrated MCA internally records pulse height spectrums for a
detector. This can be used to quickly and reliably configure the detector without a
neutron source, using only environmental or ‘background’ neutrons. The pulse height
spectrum is also a valuable diagnostic monitoring tool, allowing the user to verify that
the detector system is operating properly.
Helium-3 (He3 or 3He, both notations are used in this document) , Boron Trifluoride
(BF3 or BF3, both notations are used in this document), and Boron-lined proportional
gas tubes are often used in to detect thermal neutrons. These detectors have well
characterized pulse height spectra (histograms) that depend upon the detector
geometry, gas composition, pressure and other factors. As one of these spectra is
developed, in some cases sharp features can be identified quickly. For example, a He3
detector has a salient peak in its spectrum. Once this feature is identified, the NPM’s
high voltage, gain and discriminator settings can be configured to optimize the system,
make full use of its dynamic range and set the lower discriminator to maximize neutron
counts.
Use of the pulse height spectrum in configuring an NPM and proportional detector is
superior (faster and more accurate) compared to the so-called ‘high voltage plateau’
technique. The plateau method attempts to roughly infer the shape of pulse height
spectrum in order to optimize the high voltage, gain and discriminator settings. This
method can be time consuming, especially in the case of low neutron count rates.
Having the pulse height spectrum available makes the plateau method unnecessary.
The NPM3100’s MCA enables “real-time” monitoring of the proper function of the
neutron detector system since a detector’s pulse height spectrum is a good gauge of its
health. If a detector’s spectrum changes over time, its shape may provide information
about the failure mode. For example, the spectrum may indicate whether the problem is
with the detector or the electronics, or whether environmental factors such as humidity
are involved. In some cases, a failing detector can be retuned so that it can continue to
operate and provide good data.
The following sections present classic pulse height spectra for He3, BF3, and Boronlined gas proportional detectors. For comparison, a brief discussion of the High Voltage
Plateau Method is included.
The user of Quaesta Instruments Neutron Pulse Modules may find references such as
Glenn F. Knoll’s book Radiation Detection and Measurement useful in understanding
neutron detector pulse height spectra and detector operation in general.
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8.1 Helium-3 Detector Spectra
A typical pulse height spectrum for a He3 tube acquired in the laboratory is shown in
Figure 43 Figure 43. Different gas pressures and tube designs will alter the
appearance somewhat but the basic features will remain.
The location of the Peak relative to the Lower Edge of the so called “Wall Effect
Continuum” is a property of the gas used in the detector. For 3 He gas an alpha particle
and a triton are produced when a neutron reacts with a 3 He nucleus, i.e.
3
1
2 He + 0n

→ 13He + 11p , Q-value= 0.764Mev . In this case the ratio:
E3H
E3H + E p

=

0.191Mev
= 0.25
0.191Mev + 0.573Mev

This ratio can also be found from the histogram (for 3 He gas detectors) as

Bin # of Lower Edgeof Continuum
= 24/97 ~ 0.25 ; see
Bin # of Peak Location

Figure 43

Figure 43: Typical He3 Histogram (Pulse Ht Spectrum)
A counting “valley” is located to the left of the wall effect continuum and separates the
neutron generated pulses from lower amplitude pulses created through gamma ray
background and electronic noise.
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To count all measured neutrons with maximum insensitivity to changes in operating
voltage, electronic gain, and tube performance, set the lower discriminator in the
counting valley region. To ensure immunity from gamma ray counts, set the lower
discriminator further to the right in the wall effect region.
The pulse height spectrum helps a user consistently, reliably, and repeatedly set the
voltage, gain, and lower and upper discriminators to achieve his goals.

8.2 BF3 (Boron-10 enriched) Detector Spectra
For BF3 (B-10 enriched) gas detectors, the spectrum has the general characteristics
shown in Figure 44Figure 44 and is well characterized in the literature. Different gas
pressures and tube designs will alter the spectral shape somewhat. The dual peaks in
this pulse height spectrum are a result of the branching of the reaction between the
excited state and ground state of the 7 Li product nucleus.

BF3 Gas Proportional Tube,
Pulse Height Spectrum
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Relative Pulse Height
Figure 44: Typical BF3 Histogram (Pulse Height Spectrum)
A counting valley is located to the left of the wall effect continuum and separates the
neutron generated pulses from lower amplitude pulses created through gamma ray
background and electronic noise.
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8.3 Boron-10 Lined Tube Spectrums
Boron-10 lined tubes introduce boron as a solid coating on the interior walls of a
proportional counter tube. The interactions with incoming neutrons occur in the wall of
the tube. The nuclear reactants are a Lithium-7 nucleus and an alpha particle.
Due to momentum conservation, reaction products are oppositely directed, and one
goes into the fill-gas and produces an ionization signal while the other is directed into
the tube wall and does not produce any signal. This behavior leads to a pulse height
spectrum without a central peak and without a counting valley. The result is a spectrum
with the characteristic shape shown in Figure 45Figure 45.

Boron-Lined Tube
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Figure 45: Typical Boron-10 lined Tube Histogram (Pulse Height Spectrum)

Configuring Boron-10 lined tubes with the use of NPM3100 series pulse height spectra
ensures consistency across multiple detectors. High voltage, gain, upper and lower
discriminator settings can easily be selected in a consistent way with respect to the
detectors’ spectra.
Although Boron-10 lined gas proportional tubes lack a counting valley they can be used
to produce stable and reliable neutron measurements over time if they are set up and
monitored properly.
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8.4 Using Histograms to Tune the NPM Operating Parameters
Lower Discriminator: A Lower Discriminator setting acts as a low threshold for
neutron pulse counting and pulse height recording. If pulse heights are lower than the
Lower Discriminator level, then they are not counted or recorded by the NPM. The
Lower Discriminator level is selected in terms of histogram bin number. For a typical
128 bin He3 histogram, if the central peak is located at bin 100, then the counting valley
will be located approximately in the low 20’s bin number range. See section 8.1 for more
information.
If the Lower Discriminator is set to the left of the counting valley, then gamma rays and
electronic noise canl begin to contaminate the neutron counts. Neutron count sensitivity
is maximized by setting the lower discriminator in the counting valley, but immunity to
noise can be enhanced (if the user desires) by setting the discriminator to the right of
the counting valley in the shelf region of the spectrum.
Gain: By increasing the amplifier gain, one increases the measured pulse heights which
has the effect of sliding the peak to the right in the spectrum. Changing the gain
expands and compresses the histogram along the horizontal axis. Increasing the gain
will amplify the neutron pulse heights but will also amplify the gamma ray signal and
electronic noise.
High Voltage: Increasing/decreasing the high voltage applied to the tube will also
amplify/reduce the pulse heights. Increasing the pulse heights via the high voltage,
rather than changing the electronic gain, has the benefit of amplifying the detector
generated pulse heights while not amplifying the electronic noise. However,
neutron detector tube manufacturers generally provide a recommended operating
voltage at which the detector has been designed for optimal performance. In addition,
increased operating voltage can lead to a greater incidence of spurious counts due to
high voltage breakdown or reduced tube lifetime for some tubes. If the tube operation is
sensitive to higher humidity, then increased operating voltages can sometimes increase
such sensitivity.
Upper Discriminator: The Upper Discriminator allows one to filter out pulse heights
which are higher than a chosen value. The NPM3100 series devices count pulse
heights greater than the Lower Discriminator bin number and lower than or equal to the
Upper Discriminator bin number.
Histogram Bins are numbered from 0 to nBins-1. A 128 bin histogram will have bins
numbered from 0 to 127. Setting the Upper Discriminator setting to 127 or higher
results in effectively no Upper Discriminator at all; i.e. all pulse heights greater than the
Lower Discriminator setting will be counted, including Full Scale pulses. Spurious
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counts in the form of high voltage breakdown events are often Full Scale (high pulse
amplitude events).
Note:
For Quaesta Instruments NPM devices, the Upper Discriminator setting does not affect
the recorded histogram but does affect the counted pulse tally. That is, pulses with
pulse heights greater than the Upper Discriminator setting will still show up in the
recorded pulse height spectrum histogram but will NOT be included with the total
neutron count. This arrangement allows the user to monitor the number of high
amplitude pulses in the spectrum while not counting these pulses as neutron events.

8.5 High Voltage Counting Plateau Generation
Note:
Use of the integrated MCA in Quaesta Instruments Neutron Pulse
Modules allows one to set up their neutron detectors in Minutes
without generating a traditional High Voltage Plateau Curve. The
information below is provided as a reference.
If an MCA is not available for a Neutron Pulse Module, then a pulse height spectrum
cannot be produced. However, some information about the underlying spectrum is
necessary to properly configure the Neutron Pulse Monitoring electronics and detector.
An alternate approach to using the spectrum directly is to infer the underlying spectrum
using the “High Voltage Counting Plateau” Method. The Total counts reported by a
Neutron Pulse Module is the integral of the pulse height spectrum between the upper
and lower discriminators. The High Voltage counting plateau method involves recording
the Total counts while sweeping the High Voltage and keeping the Gain, Lower
Discriminator and Upper Discriminators constant.
Note that while all Quaesta Instruments Neutron Pulse Modules have an Upper
Discriminator, many industry utilized Neutron Pulse Monitoring devices do not have an
Upper Discriminator. The use of the Upper Discriminator allows one to filter high
amplitude pulses such as may be generated from spurious counts or High Voltage
breakdown in the Detector or the Detector insulator. If one wishes to generate High
Voltage plateau curves similar to those produced when
Traditional High Voltage Plateau curves are generated by sweeping the High Voltage
and recording counts (while keeping the Electronic Gain and Lower Discriminator fixed)
A typical Total Counts vs High Voltage curve produced will look something like that
shown in Figure 46.
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The curve is generated by adjusting the high voltage and measuring the neutron count
rate at that voltage, and then changing the high voltage and repeating. The Counting
Plateau region is that region where the Count rate changes the least with changing
voltage. To produce a well-defined or sharper plateau curve, a number of data points
must be generated.
Note: If the neutron count rate is low, which is likely the case unless the user has a
neutron source, then data must be taken for a longer time period at each high voltage
setting to achieve good signal to noise as dictated by Poisson statistics. The sharper
the plateau curve, the better one can infer the shape of the underlying pulse height
spectrum. Therefore, a useful plateau curve requires many data points with good signal
to noise, and without a neutron source, acquiring such data can be time consuming.
Proper selection of NPM parameters will result in operation in the ‘counting plateau
region’ of the Total Counts vs Voltage curve. In such a configuration the NPM and
detector system is maximally insensitive to changes in gain, high voltage, and even the
discriminator level. If done properly, the lower discriminator will have been set at or
near the counting valley of the pulse height spectra seen in Figure 43 and Figure 44.

Figure 46: Traditional Counts vs High Voltage Plateau curve for He3 and BF3 tubes
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Note:
Use of the integrated MCA in Quaesta Instruments Neutron Pulse Modules allows
one to set up their neutron detectors in Minutes without generating a traditional
High Voltage Plateau Curve. Generating a traditional neutron counting plateau can be
quite time consuming. Neutron sources are often needed to accomplish the task in a
timely fashion.
Furthermore, Boron-10 lined proportional gas tube pulse height spectrums do not have
a counting valley and, therefore, will not have a high voltage plateau at all.
It is obvious that use of the Pulse Heigh Spectrum generated by an MCA, such as that
in Quaesta Instruments NPM devices, allows the user to much more quickly and
reliably set up a Neutron detector system such that its High Voltage, Gain, Lower and
Upper Discriminators are configured to operate in a Counting Plateau regime. The user
is in complete control of the device configuration.
Another beneift of the integrated MCA is monitoring of the detector systems is also
enabled, allowing the user to verify that the Detector system is properly counting.

8.6 Detector Configuration Examples
This section contains recommended procedures for configuring an NPM3100 device
with He3 or BF3 detectors. The procedures are meant to make good use of the
dynamic spectrum of the NPM to maximize neutron counts; and to optimize stable
operation over time. They involve setting the lower discriminator in the spectrum’s
counting valley. The user may modify these procedures as needed for his particular
application. For example, if immunity to noise is a priority, the lower discriminator can
be set above (to the right of) the counting valley, further from low level noise and
unwanted gamma ray signal.
8.6.1 Procedure for Configuring Helium-3 Detectors
1.
2.
3.
4.

Set the number of Histogram Bins to 128. (Factory default).
Set the high voltage near the Tube manufacturer’s recommended operating
voltage.
Set the gain so that the location of the central peak is at approximately Bin 100.
Set the lower discriminator in the 20 – 23 bin range. The low edge of the shelf
continuum should be at approximately bin 24-25. If the gamma background and
other low amplitude noise are well behaved then this will place the lower
discriminator in the counting valley. (See 8.1 Helium-3 Detector Spectr).
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For greater immunity to noise and gamma ray pile up signal, set the lower
discriminator to the right of the counting valley. (See 8.1 Helium-3 Detector
Spectr).
Set the upper discriminator value as desired to filter high pulse amplitude events
as desired. Remember that histogram bin numbers range from 0 to (nBins -1). If
the upper discriminator is set to the maximum histogram value, bin 127 in this
case, then this effectively deactivates the upper discriminator entirely. Full scale
events that saturate the device’s analog-to-digital converter (ADC) will all be
counted as valid neutron events, though they would likely not be neutrons if the
central peak is set near bin 100. Setting the upper discriminator bin to something
less than 127, i.e. UpperDisc=126 removes from the neutron counter all events
with a pulse height of bin 127 or higher. This filters out all events that saturate
the ADC which are generally not caused by neutrons.

8.6.2 Procedure for Configuring Boron Trifluoride Detectors

1.
2.
3.
4.

Set the number of histogram bins to 128. (Factory default).
Set the operating high voltage near the Tube manufacturer’s recommended
operating voltage.
Set the gain so that the location of the central peak is located at or near bin 85 in
the spectrum.
Set the lower discriminator level to the 27-30 bin range (the low edge of the
continuum should be somewhere near bin 30). If the gamma background and
other low amplitude noise are well behaved then one can set the discriminator in
the counting valley. See section 8.2 BF3 (Boron-10 enriched) Detector

Spectr.
5.

For greater immunity to noise and gamma ray pile up signal, set the lower
discriminator to the right of the counting valley. See section 8.2 BF3 (Boron-10

enriched) Detector Spectr.
7.

Set the upper discriminator value as desired to filter high pulse amplitude events.
Remember that histogram bin numbers range from 0 to (nBins -1). ). If the
upper discriminator is set to the maximum histogram value, bin 127 in this case,
then this effectively deactivates the upper discriminator entirely. Full scale
events that saturate the device’s analog-to-digital converter (ADC) will all be
counted as valid neutron events, though they would likely not be neutrons if the
central peak is set near bin 100. Setting the upper discriminator bin to something
less than 127, i.e. UpperDisc=126 removes from the neutron counter all events
with a pulse height of bin 127 or higher. This filters out all events that saturate
the ADC which are generally not caused by neutrons.
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6.
8.6.3 Counting Plateau Generation with the NPM3100
Though configuring an NPM and detector using the pulse height spectrum is highly
recommended, the NPM3100 may be used to generate a high voltage or gain swept
counting plateau. The NPM has features which aid in this process. The user can easily
set the high voltage, gain and discriminator levels and vary any or all of these using the
device Command Set. An integral digital counter in the NPM will count neutron pulses
within a user specified time window which should be selected based upon the neutron
count rate and desired signal to noise of the data points taken. A plateau can be
generated by hand using a terminal interface and plotting data in an external program
such as Excel. See Section 8.5 High Voltage Counting Plateau Generation for a
discussion.
Another possible approach is to use an external software application to automatically
produce a counting plateau using the NPM3100 device. In this method, the software
application would call the device Command Set and generate a plateau in much the
same way a user does by hand, but the process would be automated.
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NPM3100 Command Quick Reference Tables

A quick reference list of available commands and parameters are included in the tables
below. Commands are sent in text format via the communications interface.
Commands should be terminated with a Carriage Return and Linefeed character
sequence (i.e. CR+LF). Terminal emulators such as Tera Term Pro or Windows
Hyperterminal can be configured to communicate with NPM3100 devices. Since the
USB interface on the NPM3100U device can present itself as a Virtual COM Port to a
computer and thereby emulate an RS232 device, the user may communicate via a user
created RS232 interface application.
A GUI application provided by Quaesta Instruments can also be utilized to communicate
with NPM3100 devices. Both the command prompt based Command Set and the GUI
application make use of the basic NPM3100 firmware commands identified in the quick
reference tables below. Detailed command descriptions are can be found in section 7
Device Command Set.
Commands are not case-sensitive (i.e. they are case-insensitive).
The device Command Set has three general types of commands:
C
R
R/W

– Control Commands
– Read Commands
-- Read/Write Parameter Commands

Read/Write parameters can be queried or read by simply typing the name (i.e., ‘Gain’)
and can be written or set by using an equal sign after the parameter (i.e. ‘Gain=3.8’).
The quick reference tables below are organized below by command functionality and
subsystem.
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Miscellaneous Device Commands and Parameters
Type
R/W
R
R
R
R
R
C

Operation
Name of the NPM device
Report all available commands
Report all available commands
Report device identification and parameters
Noise Standard Deviation
Seconds since device startup
Reset the system

Table 16: Miscellaneous Device Commands
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NPM Neuchrometer Commands and Parameters

Name

Type

Operation

Voltage

R/W

MaxVoltage

R/W

Gain
DiscLow or
LowerDisc
DiscHigh or
UpperDisc
DeadTime
PeakMode
PulseWave
LEDMode
Counts
Query
Cps
ZeroCounts
TTLOutMode
TTLOutWidth
TTLCounter
TTLCounts
TTLQuery
ZeroTTLCounts
PulseSim

R/W

High Voltage Supply value in Volts (250 to MaxVoltage)
Maximum allowed High Voltage (0 to HV range maximum,
Model version specific, ie NPM3100E-2.5kV)
Amplifier Gain (1.0 to 20.0)

R/W

Lower Discriminator (Neutron Pulse Threshold)

R/W

Upper Discriminator

R/W
R/W
R/W
R/W
R
R
R
C
R/W
R/W
R/W

Pulse detection dead-time or “lockout” time (sec)
Pulse peak display mode - not typically used (0 or 1)
Display waveform of the next received pulse
LED activation mode (0 or1)
Report and zero the total neutron pulse counts
Report the total neutron pulse counts without zeroing
Report the counts per second
Zero the neutron pulse counter
Configures the TTLOut Feedthrough of TTLInput
TTLOutput pulse width for Neutron Generated Pulses
Disables and Enables the external TTLInput counter (0 or 1)
Display and Zero the TTLInput counter and elapsed time
Display and Not Zero the TTLInput counter and elapsed time
Zeroes the TTLInput counter and elapsed time
Pulse Simulation Period in usec

R
R
C
R/W

Table 17: NPM Subsystem Commands and Parameters
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Multichannel Analyzer (MCA) Commands and Parameters

Requires device with MCA (-MCA) option.
Name

Type

Operation

Hgm

R

Report the histogram according to HgmMode

MaxHgm

R

Report histogram maximum information

ZeroHgm
HgmMode

C
R/W

Nbins

R/W

Zero the histogram
Histogram output format (1,2,3)
Number of Bins used in the integrated Multi-Channel
Analyzer histograms

Table 18. Multichannel Analyzer (MCA) Commands and Parameters

A.4
Delta-Time (Differential Arrival Time) Spectrum Commands
and Parameters
Requires device with Delta-T Histogram option.
Name

Type

Operation

DTRes

R/W

Delta-Time resolution (microsec)

DTHgm

R

Report Delta-T Histogram

ZeroDTHgm

C

Zero the Delta-T Histogram

Table 19. Delta-Time (Differential Arrival Time) Spectrum Commands and Params

A.5

Sensors Commands

Requires device with Delta-T Histogram option.
Name
Temperature
Humidity

Type
R
R

Operation
Temperature and Relative Humidity
Temperature and Relative Humidity

Table 20. Sensors Commands
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Data Logging Commands and Parameters

Requires device with Datalogging (-DL) option.
Name

Type

Operation

PrintDAT
LogDAT

R/W
R/W

Print Data Record to Terminal each Recordperiod
Save Data Record to SD Card each Recordperiod

RecordPeriod
NewFilePeriod
Time
LogMode
ShowFilenames
PrintHGM

R/W
R/W
R/W
R
R
R/W

LogHGM

R/W

RecordsPerHGM

R/W

LogTemp
LogHum
LogTTLCounts

R/W
R/W
R/W

Data Sampling period, in seconds: >= 3 seconds
NewFile creation period: Day, Month, Year
Report or Set Time and Date
Report Current Data Logging settings
Report Active DAT and HGM Filenames
Print HGM to terminal each Recordperiod
Save HGM to SD card according to
RecordsPerHGM and Recordperiod parameters
Number of Records between Sampled and Zeroed
HGMs
Log Temperature in each Data Record
Log Humidity each Data Record
Log TTLInput Counts

Table 21. Datalogging Commands and Parameters
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File System Commands and Parameters

Requires device with Datalogging (-DL) option.
Name

Type

Operation

Dir
GetCwd

R
R

Report files in directory
Reports the current working directory

DiskInfo
FileInfo A.B
Type A.B
Cd A

R
R
R
C

0: or 1:

C

Copy A.B X.Y
Rename A.B X.Y
Attrib ?? A.B
Del A.B
MkDir A
Format

C
C
C
C
C
C

Report bytes free and size of SD cards
Report File Information
Print to the output the File A.B
Change directory to A
Set current disk to 0: or 1: (NPM3100 series has only
0: internal card)
Copy file
Rename file
Set or change attributes of a file.
Delete a file.
Make a new file directory
Format the 0: internal SD card. Caution!

Table 22. File System Commands and Parameters

A.8

ListMode Commands and Parameters

Requires device with ListMode (-LM) option.
Name

Type

Operation

ListMode

R/W

Turns Off/On (0/1) ListMode data logging

ListMax

R/W

Number of ListMode records (pulses) to log

ListStatus
ListView

R
C

ListStream

R/W

ResetTime

C

Current ListMode data record number
Convert binary ListMode data file to Text or Hex rep
Real-Time Streaming of ListMode events… No
Logging. 0->Off, 1-Text, 2-Hex Rep, 3-Binary
Resets ListMode timestamp timer.

Table 23. ListMode Commands and Parameters
118

NPM3100 Operation Manual and Specifications
Quaesta Instruments LLC

A.9

October 12, 2018

NPM3100E Network (Ethernet) Parameters

Command Quick Reference Table
Name

Type

Operation

IPAddress

R/W

NetMask

R/W

Device IP Address. Be careful when changing this
value. Record the newly set IP Addr. Will become
active after device reboot or power cycle
Subnet mask, i.e. 255.255.255.0

GatewayAddress

R/W

Gateway Address

Table 24. NPM3100E Network (Ethernet) Parameters
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NPM3100U Communication via COM Port

The NPM3100U USB interface will present itself in Windows as a Virtual COM port,
i.e., USB Serial Port. See Ctrl Panel -> Device Manager, as in Figure 47. The
‘Ports’ section will list the NPM3100U interface as a USB Serial Port. Older
Windows versions (Windows XP) may need to download and install FTDI drivers
from the FTDI website (http://www.ftdichip.com/Drivers/VCP.htm).
After the Virtual COM port (COM 12 in Figure 47) is assigned by Windows, PC
applications can communicate to the NPM3100U device a standard RS232 interface
device.

Figure 47. Device Manager Virtual COM Ports

NPM3100U COM Port Settings:
Baud Rate: 115200
Data Bits:
8
Parity:
NO Parity
Stop Bit:
1
Flow Control: None

Note: When configuring a Terminal Program, make sure
commands transmitted to the NPM3100 devices are
terminated by a CR + LF (Carriage Return + Linefeed
Sequence).
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Connection to NPM3100U via TeraTerm Pro

TERMINAL Configuration
Teraterm Pro is a very good freely available Terminal interface program which
can be used to Interface directly to the NPM3100U device. Other terminal
interface programs which provide for RS232 connectivity can also be used, such
as Windows Hyperterminal or PuTTY. Settings similar to those described for
TeraTerm Pro should be used.
The latest version of Teraterm Pro can be downloaded from:
http://ttssh2.sourceforge.jp/index.html.en
After installed, the TeraTerm Pro window will appear as in Figure 48

Figure 48. Teraterm Default Window
Open a new connection (File->New Connection), as in Figure 49 and select the USB
Virtual COM port corresponding to the attached NPM3100U device.

Figure 49. TeraTerm New Connection Window
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Configure the Terminal through the menu Setup-> Terminal. See Figure 50. The
New-line configuration Transmit option must be set to CR+LF. Other suggested
configuration options are shown in Figure 50 as well.

Figure 50. TeraTerm Terminal Setup Window
Configure Teraterm’s Serial Port settings through the menu Setup -> Serial Port. See
Figure 51Figure 51.
Serial Port Settings are: 115200 baud, 8 Data bits, No Parity, 1 Stop Bit, and No Flow
Control.

Figure 51. TeraTerm Serial Port Setup
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Connection to NPM3100U via Hyperterminal

Tera Term Pro is recommended as a terminal interface program for use with NPM3100
series products. However, Windows Hyperterminal or other COM port terminal capable
applications will allow communication with NPMs as well. This section describes
connecting to an NPM3100U device using Hyperterminal.
Windows Hyperterminal is available as a free utility on Windows XP machines and for a
small nominal cost for Windows 7 and later Windows operating platforms. See Figure
52.
Windows Hyperterminal can also be purchased for use on Windows 7 machines.

Figure 52: Windows Hyperterminal Main Window
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Figure 53 shows Hyperterminal’s New Connection Window available from the
Hyperterminal File=>New Connection menu selection.

Figure 53: Windows Hyperterminal New Connection

Figure 54 shows the Window displayed after the OK command button in Figure 53 is
clicked. Select the Virtual COM port assigned to the NPM device (see).

Figure 54: Hyperterminal COM Port Selection
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Select the “Configure” command button and the COM Port Settings selection window
shown in Figure 55. Select 115200 Baud, 8 Data Bits, No Parity, 1 Stop Bit and No
Flow Control.

Figure 55: Hyperterminal COM Port Settings

From the Hyperterminal Main Window, select File=> Properties to open a window of the
form shown in Figure 56

Figure 56: Windows Hyperterminal Connection Properties.
Figure 57 shows options available via the Settings Tab of Figure 56. Select VT100
and a Backscroll buffer size of 500 lines (the maximum allowed).
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Figure 57: Hyperterminal Terminal Settings
Next, select the “ASCII Setup” button and a form as in Figure 58 will appear. Select the
“Send line ends with line feeds” checkbox. This is necessary as all commands sent to
the NPM3100 device must terminate with a Carriage Return + Line Feed character
sequence (these are Hex characters 0x0D and 0x0A).

Figure 58: Windows Hyperterminal CR + Line Feed Setup.
Lastly, the user may desire to change the font size of the text shown in the terminal
window as the default Windows Hyperterminal font size is quite large.
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From the main Hyperterminal window select View->Font and a form as shown in Figure
59 will open. The user can select his Font and Font Size preference, but those shown
in Figure 59 are a suggestion.

Figure 59: Windows Hyperterminal Font Setup.
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Firmware Upload Procedures

Quaesta recommends that new firmware be uploaded only if one or more of the
following conditions is met:
1. A Firmware upgrade is desired for new functionality or if a relevant bug has
been addressed and fixed in a firmware update.
2. The NPM3100 device firmware is corrupted. This should be a very rare
occurrence as the microcontroller and firmware used in the NPM3100 device
has been designed to operate many years without failure.
There are several firmware upload procedure options available to the NPM3100 user.
Each one of these firmware upload procedures relies upon the presence of a small
bootloader firmware program resident in the NPM3100 device. The bootloader is the
first microcontroller code which runs upon system reset. A reset occurs when power is
cycled, a brown-out reset occurs, the watchdog timer expires, or a user issues the
reboot command.
New Firmware can be uploaded easily if existing device firmware is intact and the
NPM3100 device is functional. One of two firmware upload procedures can be used:
1. Use of the External SD card (if present) on the device. This requires local
access to the device’s external SD card and the ability to cycle the NPM
power. This procedure can also be used if the main firmware code is
corrupted. (Note: NPM3100 series devices do not have external SD cards).
2. Via Tera Term Pro, a Windows based terminal emulation program. The
Xmodem file transfer is utilized. The sequence of steps is time critical, and
therefore the user is encouraged to practice in the laboratory first before using
this procedure on a field unit. Use of Tera Term Pro may also require the
cycling of the power on the NPM electronics. This procedure can be used if
the main firmware code is corrupted, but power cycling of the NPM
electronics portion of the NPM3100 device will be required to gain access to
the bootloader program.
Note: If the NPM3100 device firmware is corrupted, then new firmware can still be
uploaded as long as the NPM3100 device bootloader program is still resident and
functioning.
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C.1 Firmware Upload using the Quaesta Instruments GUI
This Manual Section is in Progress.

C.2 Firmware Upload Using the External SD card.
**External SD Card is Not present in all devices.
FW upgrade of Quaesta NPM device can be accomplished via the External SD card if
the unit contains an external SD card and physical access to the device is available.
The following procedure should be followed:
1. Obtain an appropriate NPM firmware upgrade file from Quaesta Instruments for
the model of device being upgraded. This file wil have a “.bin” or “*.crp”
extension. i.e., filename will have form of “NPMXXX.bin” or “NPMXXX.crp”
2. Remove the External microSD card and copy the obtained bin file to the top level
directory of the microSD card, renaming the file if necessary to “NPMXXX.bin” or
as “NPMXXX.crp” as appropriate.
Important: The filename on the microSD card must have the filename
“NPMXXX.crp”.
3. Power cycle the NPM device and the device bootloader will search for the
NPMXXX.bin or NPMXXX.crp file as appropriate. If found, the new firmware will
be uploaded. Once successful, the unit will begin running the new firmware.
The user may find it useful to monitor the FW upload process by connecting to the
device first with a terminal emulation program such as Tera Term Pro or Windows
Hyperterminal.
Upon power cycle terminal output from the unit will pause while the SD cards are power
cycled. During FW upload from an NPMXXXX.bin or NPMXXXX.crp file, a series of
dots will be printed as the bootloader loads blocks of data from the SD card firmware
file. When new firmware is successfully loaded the firmware will run, displaying the
informational header and list of parameter values as shown in the example output on
the next page.
Note: It is recommended that the user remove, rename, or delete the
NPM3XXX.bin or NPM3XXX.crp file from the External microSD card after
successful firmware upgrade. If the NPM3XXX.bin file is left on the external
microSD card, the NPM3XXX bootloader will attempt to reload the new firmware
each time the unit is power cycled or rebooted. This will likely not cause any
problems, but if a power glitch or other anomaly occurs during a firmware upload
from the external microSD card, the loaded Firmware may be corrupted. In such
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a case the unit may need to be power cycled again for the firmware to be read
from the SD card and loaded properly.
Example:
Retrieve an appropriate FW binary file by contacting Quaesta Instruments LLC support.
Copy the firmware file to the NPM3XXX device external SD card, making sure it is
named NPM3XXX.bin or NPM3XXX.crp as appropriate for the NPM model.
For example:
dir
1:/ External SD Card
----A 2013/01/21 22:15
106236 NPM3100U.crp
1 File(s),
106236 bytes total,
0 Dir(s)
1:/ External SD Card
Upon power cycle or reboot the NPM3XXX bootloader will search for the NPM3XXX file
on the external SD card, and if present, begin loading the new firmware into its main
Firmware program space.
reboot
.............................................................................
.............................................................................
......................................................
Quaesta Instruments, LLC
www.QuaestaInstruments.com
Firmware Version
1.0.8
BootLoader Version 2
Model
NPM3100
Model Version
USB
Serial Number
0123456789ABCDEF
Time Constant
3us
Name
Name
Identifier
255
***NEUCHROMETER PARAMETERS***
Voltage Set
950
Voltage Measured
0.0
MaxVoltage
2500
Gain
3.0
DiscLow
10
DiscHigh
127
DeadTime
30
PeakMode
0
LEDMode
1
TTLOutMode
1
TTLOutWidth
100
TTLCounter
1
PulseSim(uS)
OFF
nBins
128
HgmMode
2
DtResolution
1000
***LOGGER PARAMETERS***
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RecordPeriod(Sec) 60
NewFilePeriod
Day
RecordsPerHGM
60
PrintDAT
0
PrintHGM
0
LogDAT
1
LogHGM
1
LogTemp
1
LogHum
1
LogTTL
1
ListSectors
1
Current Time
2015/08/31 11:41:49
File Created: /DAT/Name_1508311141.DAT
File Created: /HGM/Name_1508311141.HGM
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C.3 Firmware Upload Using Tera Term’s Xmodem File
Transfer
The presence of a working bootloader is necessary in order to upload new firmware to
the NPM3100 device.
The recommended method of firmware uploading to the NPM3100 devices is via the
GUI application firmware upgrade tool provided in the Quaesta Instruments GUI
NPM3100 GUI interface application.
For completeness, uploading new firmware to the NPM3100 devices via Tera Term Pro
is presented. In this case the Xmodem file transfer option available in Tera Term may
also be used to upload Firmware via the Xmodem file transfer protocol.
When a working bootloader is present on the NPM3100 series device, at device power
on or reboot a series of 6 or more question marks spaced 1 second apart will be
transmitted to the terminal output, beginning a few seconds after power on or reboot.
During the period of question mark display, the bootloader is operating and waiting for a
FW upgrade process to be initiated, described below. If the upgrade process is not
initiated after a set number of question marks, then the NPM 3100 device will load and
run its resident program.
A summary of steps for uploading new Firmware is listed here for reference. See below
for more detailed instructions.
Step 1. Either power cycle the unit or type ‘reboot’ in the terminal (no quotes).
Step 2. Enter <CTRL-Q> at the question marks. Wait for directions.
Step 3. Select XMODEM file transfer and select the file (make sure to select the CRC
radio button in the file dialog)
Step 4. If FW uploads properly a progress box will indicate 100% complete and the new
firmware will run displaying the current NPM3100 operating parameters.
Note that if the new firmware does not load the user may have to power cycle the
device and repeat the firmware upgrade attempt. If main code firmware is not present
on the NPM3100 device or the firmware main code is corrupted or incompletely loaded,
then the unit will display a series of question marks (??????????) and may appear to
“hang”, becoming unresponsive. The unit will need to be power cycled if this occurs.
After power cycle the series of question marks should begin again, allowing for another
opportunity for firmware upload.
After Power Cycling or Device Reboot->
???????????
Quaesta Instruments, LLC
www.QuaestaInstruments.com
Firmware Version
1.X.X
BootLoader Version 2
Model
NPM3100
Model Version
USB
Serial Number
0123456789ABCDEF
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3us
Name
255

***NEUCHROMETER PARAMETERS***
Voltage Set
950
Voltage Measured
0.0
MaxVoltage
2500
Gain
3.0
DiscLow
10
DiscHigh
127
DeadTime
30
PeakMode
0
LEDMode
1
TTLOutMode
1
TTLOutWidth
100
TTLCounter
1
PulseSim(uS)
OFF
nBins
128
HgmMode
2
DtResolution
1000
***LOGGER PARAMETERS***
RecordPeriod(Sec) 60
NewFilePeriod
Day
RecordsPerHGM
60
PrintDAT
0
PrintHGM
0
LogDAT
0
LogHGM
0
LogTemp
1
LogHum
1
LogTTL
1
ListSectors
1
Current Time
2015/09/14 11:41:49

If the user types a “CTRL Q” when the question marks are displayed the NPM3100
device will prepare for a firmware upgrade via the Xmodem CRC protocol. The user
should see a message from the device indicating that the existing application will be
erased. Select Y if you wish to proceed.
reboot
??
->User enters <CTRL-Q) here
Existing application will be erased.
Do you really want to continue? (Y or N)
Y
->Make sure to enter Capital Y
Erasing Sector 1
Erasing Sector 2
Erasing Sector 3
Erasing Sector 4
Erasing Sector 5
Erasing Sector 6
Erasing Sector 7
Transfer file using XMODEM-CRC
CCCCCC
->Do not Type any Characters at the C
->User selects File as in Figure 60: Tera Term XMODEM Firmware Upgrade File Selection

When C’s begin, do not type any characters, and with the computer mouse, Select File>Transfer->XMODEM->Send…
A File Selection Box of the form shown in Figure 60 will appear.
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Make sure the CRC radio button is selected at the bottom of the window.
Navigate to the folder which contains the desired NPMXXXX firmware *.crp file and
select the file. Select the Open command button and the firmware will be uploaded. A
progress box of the form shown in Figure 61 will be displayed.

Figure 60: Tera Term XMODEM Firmware Upgrade File Selection

Figure 61: Tera Term XMODEM Firmware Upgrade Progress
CCCCCC
(User selects File as in Figure 60. Then Figure 61 will appear ).
➔ Firmware is Loaded and Application Starts.
Quaesta Instruments, LLC
www.QuaestaInstruments.com
Firmware Version
1.0.8
->Should show the FWVers selected in Figure 60.
BootLoader Version 2
Model
NPM3100
Model Version
USB
Serial Number
0123456789ABCDEF
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3us
Name
255

***NEUCHROMETER PARAMETERS***
Voltage Set
950
Voltage Measured
0.0
MaxVoltage
2500
Gain
3.0
DiscLow
10
DiscHigh
127
DeadTime
30
PeakMode
0
LEDMode
1
TTLOutMode
1
TTLOutWidth
100
TTLCounter
1
PulseSim(uS)
OFF
nBins
128
HgmMode
2
DtResolution
1000
***LOGGER PARAMETERS***
RecordPeriod(Sec) 60
NewFilePeriod
Day
RecordsPerHGM
60
PrintDAT
0
PrintHGM
0
LogDAT
1
LogHGM
1
LogTemp
1
LogHum
1
LogTTL
1
ListSectors
1
Current Time
2015/09/14 16:20:49
File Created: /DAT/Name_1509141620.DAT
File Created: /HGM/Name_1509141620.HGM

The FW upgrade should not disturb the Operating parameters that were in place prior to
the FW upgrade.
.
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Appendix D Menu Command
D.1

NPM3100U Menu Command Output

The NPM3100U device has integrated TTLInput and TTLOutput functionality.
The Multi-Channel Analyzer (MCA), Delta-Time Histogram, Sensors, Datalogger,
Filesystem, and ListMode Commands will only be available if the corresponding options
are selected for the devices when ordered.
menu
*** List of available Commands (Not Case Sensitive)***
*** Cntrl-R to repeat previous command***
*** - C *** - R *** -R/W***
***
***
***
Colon***

Control commands***
Read commands
***
Read/Write parameters. Enter the parameter name to see the current value
To change the value enter the parameter name followed by the new value
Separate the parameter name from the new value with an Equal, Space, Comma, or

***Miscellaneous Commands***
Name
Menu
Help
Info
Sdev
BaudRate
bootup
UpTime
Reboot

-R/W- R - R - R - R -R/W-

Identifier: e.g. 'Name=Detector #1', maximum 16 characters
List of all commands
List of all commands
Identification and Parameters
Noise Std Dev: e.g. 'SDEV=100' is 4096 sample Sdev, averaged 100 times)
BaudRate: BaudRate=921600,921600,460800,230400,115200; back to 115200 at

- R - Seconds since Startup
- C - System reset

***Neuchrometer Commands***
Voltage
MaxVoltage
Gain
LowerDisc
UpperDisc
DeadTime
PeakMode
PulseWave
LEDMode
Counts
Query
Cps
ZeroCounts
TTLOutMode
TTLoutput
TTLOutWidth
TTLCounter
TTLCounts
TTLQuery
ZeroTTLCounts
PulseSim

-R/W-R/W-R/W-R/W-R/W-R/W-R/W- R -R/W- R - R - R - C -R/W-

High Voltage: e.g. 'Voltage=1000', maximum is MaxVoltage
Maximum Allowable Voltage: e.g. 'MaxVoltage=1500', maximum is 2000
Gain: e.g. 'Gain=5.3', from 1 to 20
Lower Discriminator: e.g. 'LowerDisc=25', maximum is nBins-1
Upper Discriminator: e.g. 'UpperDisc=127', maximum is nBins-1
DeadTime: e.g. 'DeadTime=100', in microseconds from 25 to 10000
Peak Mode: e.g. 'PeakMode=1' -> peak info
Pulse Waveform: e.g. 'PulseWave=64,2'-> first 64 wave points, format 2
LED Mode: 1 for ON, 0 for OFF
Report and Zero the Counts and the Timer
Report the Counts Without Zeroing
Report the Counts per second
Zero the Count value
TTL Out Mode: .e.g. ,TTLOutMode=1, allows TTLInput to feedthrough to

-R/W- TTL Out Width (nanosecs):
TTLOutWidth=0,25,50,100,200,500,1000,2000,5000,10000
-R/W- Eanble/Disable the TTL Counter
- R - Report and Zero the TTL Counts and the Timer
- R - Report the TTL Counts Without Zeroing
- C - Zero the TTL Count value
-R/W- PulseSim Period(uS), 0=OFF,50000,20000,10000,5000,2000,1000,500,200,100,50

***Multi-Channel-Analyzer Commands***
Hgm
MaxHgm

- R - Report Histogram, format according to HgmMode
- R - Report position of histogram max, max cts value, and total histogram counts
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- C - Zero the Histogram
-R/W- Histogram Mode: e.g. 'HgmMode=1', mode is 1,2, or 3
-R/W- Number of Histogram Bins: e.g. 'NBINS=256', 64,128,256,512,1024,2048

***Delta-Time-Histogram Commands***
DTRes
DTHgm
ZeroDTHgm

-R/W- Delta-Time resolution (microseconds): (e.g. 'DTRes=100',
1,10,100,1000,10000
- R - Report Delta-Time Histogram (fixed at 1000 bins)
- C - Zero the Delta-Time Histogram

***Sensor Commands***
Temperature
Humidity
In Progress.

- R - Temperature(Celsius) and Humidity(%Relative)(Optional)
- R - Temperature(Celsius) and Humidity(%Relative)(Optional)

***Data Logger Commands***
PrintDAT
LogDAT
RecordPeriod
NewFilePeriod
Time
LogMode
ShowFileNames
PrintHGM
LogHGM
RecordsPerHGM
LogTemp
LogHum
LogTTLCounts

-R/W-R/W-R/W-R/W-R/W- R - R -R/W-R/W-R/W-R/W-R/W-R/W-

Print Data Records: 1 for Yes, 0 for No
Save Data Records: 1 for Yes, 0 for No
Record Period in seconds{ >= 3 }: e.g. 'RecordPeriod= 3600'
NewFile Period: e.g. 'NewFilePeriod= Day', Day,Month,Year
Time and date: e.g. 'Time= 15/02/06 16:34:00'
Report current LogMode settings
Report current File Names
Print Histograms:
1 for Yes, 0 for No
Save Histograms:
1 for Yes, 0 for No
Number of records per Histogram: e.g. 'RecordsPerHisto= 100'
Include Temperature: 1 for Yes, 0 for No
Include Humidity:
1 for Yes, 0 for No
Include TTL Counts: 1 for Yes, 0 for No

***File System Commands***
Dir
- R - Report files in directory
GetCwd
- R - Report current working directory
DiskInfo
- R - Report bytes free and size of SD cards
FileInfo A.B
- R - Report file information: e.g. 'FileInfo Qwerty.dat'
Type A.B
- R - Display a file (see manual for Switches): e.g. 'Type XYZ_1501191456.DAT'
Cd A
- C - Change to a different directory : e.g. 'Cd HGM' or 'Cd..' or 'Cd /'
0: or 1:
- C - Change to the Internal drive '0:', or to the External drive '1:'
Copy A.B X.Y
- C - Copy a file: e.g. 'Copy 1105191456.DAT 1:/BackupData.TXT'
Rename A.B X.Y - C - Rename or move a file: e.g. 'Rename 1105191456.DAT
1:/ARC/DAT/BackupData.TXT'
Attrib ?? A.B
- C - Change Attributes of a file: e.g. 'Attrib +R-A 1105191456.DAT'
Del A.B
- C - Delete a file: e.g. 'Del 1105191456.DAT' or 'Del *.DAT'
MkDir A
- C - Make a new directory: e.g. 'MkDir Locker'
Format
- C - Format the internal SD card. Use with Caution!

***List Mode Commands***
ListStream
ResetTime
ListMode
ListMax
ListStatus
ListView
Hex'

-R/W- ListStream=? : 0->Off; 1,2,3->Real-Time Streaming Text,Hex,Binary
respectively
- C - Reset the TimeStamp timer to zero
-R/W- ListMode=? : 1->Record; 0->Off;
-R/W- Maximum number of List records to store: e.g. 'ListMax=100000'
- R - Report current List record number
- R - View ListMode Data (see manual): e.g. 'ListView XYZ_1501191456.LST End=100
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NPM3100E Menu Command Output

The Multi-Channel Analyzer (MCA), Delta-Time Histogram, Sensors, Datalogger,
Filesystem, and ListMode Commands will only be available if the corresponding options
are selected for the devices when ordered.
menu
*** List of available Commands (Not Case Sensitive)***
*** Cntrl-R to repeat previous command***
*** - C *** - R *** -R/W***
***
***
***
Colon***

Control commands***
Read commands
***
Read/Write parameters. Enter the parameter name to see the current value
To change the value enter the parameter name followed by the new value
Separate the parameter name from the new value with an Equal, Space, Comma, or

***Miscellaneous Commands***
Name
Menu
Help
Info
Sdev
UpTime
ClockSource
Reboot

-R/W- R - R - R - R - R -R/W- C -

Identifier: e.g. 'Name=Detector #1', maximum 16 characters
List of all commands
List of all commands
Identification and Parameters
Noise Standard Deviation: e.g. 'SDEV=10000' is 10000 sample Sdev)
Seconds since Startup
0: Low power internal; 1: High accuracy internal; 2: External master
System reset

***Neuchrometer Commands***
Voltage
MaxVoltage
Gain
LowerDisc
UpperDisc
DeadTime
PeakMode
PulseWave
LEDMode
Counts
Query
Cps
ZeroCounts
PulseSim

-R/W-R/W-R/W-R/W-R/W-R/W-R/W- R -R/W- R - R - R - C -R/W-

High Voltage: e.g. 'Voltage=1000', maximum is MaxVoltage
Maximum Allowable Voltage: e.g. 'MaxVoltage=1500', maximum is 2000
Gain: e.g. 'Gain=5.3', from 1 to 20
Lower Discriminator: e.g. 'LowerDisc=25', maximum is nBins-1
Upper Discriminator: e.g. 'UpperDisc=127', maximum is nBins-1
DeadTime: e.g. 'DeadTime=1000', in microseconds from 25 to 65000
Peak Mode: e.g. 'PeakMode=1' -> peak info
Pulse Waveform: e.g. 'PulseWave=64,2'-> first 64 wave points, format 2
LED Mode: 1 for ON, 0 for OFF, LEDMode is always ON when Ethernet is ON
Report and Zero the Counts and the Timer
Report the Counts Without Zeroing
Report the Counts per second
Zero the Count value
PulseSim Period(uS), 0=OFF,50000,20000,10000,5000,2000,1000,500,200,100,50

***Multi-Channel-Analyzer Commands***
Hgm
MaxHgm
counts
ZeroHgm
HgmMode
nBins

- R - Report Histogram, format according to HgmMode
- R - Report position of histogram maximum, maximum value, and total histogram
- C - Zero the Histogram
-R/W- Histogram Mode: e.g. 'HgmMode=1', mode is 1,2, or 3
-R/W- Number of Histogram Bins: e.g. 'NBINS=256', 64,128,256,512,1024,2048

***Delta-Time-Histogram Commands***
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-R/W- Delta-Time resolution (microseconds): (e.g. 'DTRes=100',
1,10,100,1000,10000
- R - Report Delta-Time Histogram (fixed at 1000 bins)
- C - Zero the Delta-Time Histogram

***Data Logger Commands***
PrintDAT
LogDAT
RecordPeriod
NewFilePeriod
Time
LogMode
ShowFileNames
PrintHGM
LogHGM
RecordsPerHGM

-R/W-R/W-R/W-R/W-R/W- R - R -R/W-R/W-R/W-

Print Data Records: 1 for Yes, 0 for No
Save Data Records: 1 for Yes, 0 for No
Record Period in seconds{ >= 3 }: e.g. 'RecordPeriod= 3600'
NewFile Period: e.g. 'NewFilePeriod= Day', Day,Month,Year
Time and date: e.g. 'Time= 15/02/06 16:34:00'
Report current LogMode settings
Report current File Names
Print Histograms:
1 for Yes, 0 for No
Save Histograms:
1 for Yes, 0 for No
Number of records per Histogram: e.g. 'RecordsPerHisto= 100'

***File System Commands***
Dir
- R - Report files in directory
GetCwd
- R - Report current working directory
DiskInfo
- R - Report bytes free and size of SD cards
FileInfo A.B
- R - Report file information: e.g. 'FileInfo Qwerty.dat'
Type A.B
- R - Display a file (see manual for Switches): e.g. 'Type XYZ_1501191456.DAT'
Cd A
- C - Change to a different directory : e.g. 'Cd HGM' or 'Cd..' or 'Cd /'
Copy A.B X.Y
- C - Copy a file: e.g. 'Copy 1105191456.DAT 1:/BackupData.TXT'
Rename A.B X.Y - C - Rename or move a file: e.g. 'Rename 1105191456.DAT
1:/ARC/DAT/BackupData.TXT'
Attrib ?? A.B
- C - Change Attributes of a file: e.g. 'Attrib +R-A 1105191456.DAT'
Del A.B
- C - Delete a file: e.g. 'Del 1105191456.DAT' or 'Del *.DAT'
MkDir A
- C - Make a new directory: e.g. 'MkDir Locker'
Format
- C - Format the internal SD card. Use with Caution!

***List Mode Commands***
ListStream

-R/W- ListStream=? : 0->Off; 1,2,3->Real-Time Streaming Text,Hex,Binary
respectively
- C - Reset the TimeStamp timer to zero
-R/W- ListMode=? : 1->Record; 0->Off;
-R/W- Maximum number of List records to store: e.g. 'ListMax=100000'
- R - Report current List record number
- R - View ListMode Data (see manual): e.g. 'ListView XYZ_1501191456.LST End=100

ResetTime
ListMode
ListMax
ListStatus
ListView
Hex'
***Network Commands***
IpAddress
SubNetMask
GatewayAddress
TcpPort

-R/W-R/W-R/W-R/W-

IpAddress: e.g. 'IpAddress=192.168.15.40'
SubNetMask:
e.g. 'SubNetMask=255.255.255.0'
GatewayAddress: e.g. 'GatewayAddress=192.168.15.1'
TCP/IP Port#: e.g. 'TcpPort=12400'
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